RAW Image Viewing, Processing and Editing Software

Digital Photo Professional

Ver. 2.2

Instruction Manual

Content of this Instruction Manual

- DPP is used for Digital Photo Professional.
- In this manual, the windows used in the examples are from Windows XP.
- Indicates the selection procedure of the pull-down menu.
  Example: [View] menu ➤ [Sort] ➤ [File name].
- Square brackets are used to indicate items such as menu names, button names and window names that appear on the computer screen.
- Text inside <> indicates a key on the keyboard.
- ** indicates a reference page.
  Click to move to the relevant page.
- ! Marks information that should be read before use.
- ☞ Marks additional information you may find helpful.

Switching Between Pages

- Click on arrows on the bottom right of the screen.
  ➤ : next page
  ◀ : previous page
  ◀ : return to a page you had previously displayed

- Click on the chapter headings on the right side of the screen to switch to the contents page of that chapter. Also, click the item you want to read about on the table of contents to move to the relevant page.

Help and Shortcut Keys

- For information about using DPP, refer to Help from the menu.
- Refer to the "Shortcut Key List" in the Help for a list of shortcut keys which are helpful for quick operation.
NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM. This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate without notice to you if you fail to comply with any of the terms of this Agreement and you must then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in the United States of America shall be governed and construed in all respects in accordance with the laws and regulations of the State of New York, without reference to choice of law principles. The terms of this Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the SOFTWARE is subject to the United States, Canada and other applicable copyright and trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any images, graphics or textual material that you save in connection with the Software.

10. ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
Introduction

Digital Photo Professional (hereinafter, “DPP”) is high-performance RAW image viewing, processing and editing software for EOS digital cameras. It is often thought that RAW images are difficult to handle compared with ordinary JPEG images, but using DPP, you can perform advanced edits and print RAW images with ease.

RAW Images and their Features

What is a RAW Image?
A RAW image is image data that has recorded output data of imaging sensor. Because image processing does not occur inside the camera when a photo is taken and the photo has been recorded in the special form of “RAW image data + Image processing conditions information at the time of shooting”, special software is needed to view or edit the image.
* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?
If described in terms of film, the concept of a RAW image is a shot image not yet developed (latent image).
With film, the image appears for the first time when it is developed. And as for the RAW image, too, you cannot view it as an image on your computer unless you perform subsequent image signal processing. Therefore, even though it is digital, this processing is called “development” and with EOS DIGITAL is performed using DPP.
With DPP, you can view, edit and print RAW images without having to be particularly conscious of the development processing.

What Advantages does a RAW Image Have?
RAW images are recorded in the format “RAW image data + Image processing conditions information at the time of shooting”. When you open an image in DPP, the image is instantly developed and you can view the image as an image to which image processing conditions at the time of shooting have been applied.
Even if you perform various edits to the image you have opened (it undergoes automatic development processing each time), only the image processing conditions (development conditions) change and the “original image data itself” remains unaffected. Consequently, image deterioration is not a problem and it is the perfect image data for users who want to get creative with their images after they have been shot. In DPP the “image processing conditions information” that can be edited in DPP is called a “Recipe”.

RAW image data
Image processing conditions information
Main Features of DPP

Following are the main tasks you can perform with images you have downloaded to your computer.

- View and organize RAW images
- Real-time edit of a RAW image
- Freely apply Picture Style
- Trim an image and change its size
- Automatic dust erasure processing
- Convert from a RAW image to a JPEG or TIFF image and save
- Print a RAW image
- Transfer the image to image editing software
- Process large numbers of RAW images in batches
- View and organize JPEG and TIFF images
- Real-time edit of JPEG and TIFF images
- Print JPEG and TIFF images
- Color management compatibility
- CMYK simulation for commercial printing

System Requirements

<table>
<thead>
<tr>
<th>OS</th>
<th>Windows XP (Professional/Home Edition), Windows 2000 Professional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>PC with one of the above OS preinstalled * Upgraded machines not supported</td>
</tr>
<tr>
<td>CPU</td>
<td>750MHz Pentium III or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum 512MB</td>
</tr>
<tr>
<td>Display</td>
<td>Screen resolution: 1024 × 768 pixels or more Color quality : Medium (16 bit) or more</td>
</tr>
</tbody>
</table>

Supported Images

This software supports the following image types.

<table>
<thead>
<tr>
<th>Image type/Camera used</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAW images</td>
<td></td>
</tr>
<tr>
<td>EOS-1D Mark II N</td>
<td>.CR2</td>
</tr>
<tr>
<td>EOS-1D Mark II</td>
<td></td>
</tr>
<tr>
<td>EOS 30D</td>
<td></td>
</tr>
<tr>
<td>EOS DIGITAL REBEL XTi</td>
<td></td>
</tr>
<tr>
<td>/400D DIGITAL</td>
<td></td>
</tr>
<tr>
<td>EOS D6000*1</td>
<td></td>
</tr>
<tr>
<td>EOS-1Ds</td>
<td>.CR2</td>
</tr>
<tr>
<td>EOS 10D</td>
<td></td>
</tr>
<tr>
<td>EOS D60</td>
<td>.CRW</td>
</tr>
<tr>
<td>EOS D30</td>
<td>.CRW</td>
</tr>
<tr>
<td>PowerShot Pro1*2</td>
<td>.CRW</td>
</tr>
<tr>
<td>JPEG images</td>
<td>.JPG, .JPEG</td>
</tr>
<tr>
<td>TIFF images</td>
<td>.JPG, .JPEG</td>
</tr>
<tr>
<td>Exif 2.2 or 2.21-compatible JPEG images</td>
<td>.JPG, .JPEG</td>
</tr>
<tr>
<td>Exif-compatible TIFF images</td>
<td>.TIF, .TIFF</td>
</tr>
</tbody>
</table>

*1 Images converted to RAW images that have the "CR2" extension in CR2 Converter. For information on CR2 Converter, refer to Canon's web site.

*2 You cannot edit with the DPP RAW image adjustment function.
## Contents at a Glance

### Downloading Images to Your Computer
- Download images by connecting your camera and computer ➔ p.6
- Download images using a card reader ➔ p.35

### Viewing and Checking RAW Images
- Quickly enlarge parts of an image ➔ p.9
- Sort images (check marks) ➔ p.15, p.16
- Display the images in the thumbnail list display at high resolution ➔ p.17
- Check shooting information such as the shooting date ➔ p.8, p.17

### Editing RAW Images (Adjusting)
- Adjust brightness/darkness ➔ p.10, p.18
- Use automatic adjustment ➔ p.24
- Change the Picture Style ➔ p.19
- Sharpen the modulation and contrast of colors (contrast) ➔ p.20
- Make skin tone look healthier (color tone) ➔ p.20
- Make the image colors more vivid (color saturation) ➔ p.20
- Make an image sharp (sharpness) ➔ p.22
- Adjust an image to make color tone more natural (white balance) ➔ p.22
- Change an image to black-and-white or sepia tones (monochrome) ➔ p.21

### Printing
- Print ➔ p.30, p.48
  - Print well on a Canon printer ➔ p.30, p.48
  - Faithfully reproduce the color of the subject when printing ➔ p.47
  - Print with the shooting information ➔ p.47
  - Print a thumbnail list of images ➔ p.47
- Approximate the color seen on screen with your printing results ➔ p.53, p.54

### Conversion of Images
- Convert a RAW image to a JPEG image ➔ p.29, p.59
- Edit in Photoshop ➔ p.46, p.60
- Perform batch processing ➔ p.59
- Edit (adjust) a JPEG image ➔ p.62
1 Basic Operation

The basic operational flow – from how to download to your computer images shot with a camera to checking, editing, saving and printing a downloaded RAW image – is explained here.

- Starting up DPP ......................................................... 6
- Downloading an Image to Your Computer ............ 6
- Viewing an Image ...................................................... 8
  - View Images as Thumbnails in the Main Window .... 8
  - Changing the Size of Images ................................. 8
- Enlarge and View an Image in the Edit Window ...... 9
  - Enlarging and Viewing a Specific Area ................. 9
- Adjusting an Image .................................................. 10
- Saving an Image..................................................... 11
- Printing an Image .................................................. 12
- Exiting DPP ............................................................. 12
Starting up DPP

Double-click the desktop icon.

DPP starts up and the main window appears.

Main window

Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and download the images saved on the memory card inside the camera. For downloading images, open the camera software “EOS Utility” from DPP and use.

1 Select the save destination for the images.
   - Select the save destination in the folder area on the left of the main window.
   - When creating a folder, refer to p.34.

2 Start up EOS Utility.
   - Select the [Tools] menu ➔ [Start EOS Utility].

   ![Tools menu]

   - EOS Utility starts up.
3 Connect your camera and computer and turn the camera on.

- Connect the camera’s DIGITAL terminal and your computer with the interface cable provided with the camera.
- For detailed instructions on connecting your camera and computer, refer to the “EOS Utility Instruction Manual” (Electronic manual in PDF format).

4 Download images.

“EOS Utility”

Download images.

- Click

Download images begin.

- Downloaded images are saved in the destination selected in step 1 and displayed in the main window of DPP.

For details on downloading images using a third party card reader, refer to p.35.
Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list in the main window.
Double-click an image to open the edit window and the image is displayed at larger size.

View Images as Thumbnails in the Main Window

Main window

- Click to select the image.
- Display thumbnails of all the images inside the folder selected in the folder area on the left.
- Rotate selected image.

Changing the Size of Images
You can change the size of the thumbnail images displayed as thumbnails in the main window and display them with shooting information attached.

Select the [View] menu ▶ desired item.

For a list of main window functions, refer to p.80.
Enlarge and View an Image in the Edit Window

The edit window appears.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

The area you double-clicked is enlarged to 100% (actual pixel size).

- When changing the display position, drag on the image or drag the enlargement display position in the tool palette.
- Double-click again to revert to the full view.

Tool palette enlargement display position

Change the enlargement display position by dragging.

- To select a view size other than 100% view, select the [View] menu ➔ desired enlargement ratio.
- If you double-click on an image while in [50% view] or [200% view], the view changes to the full view ([Fit to window]).

Double-click

It may take time for the image to redraw itself.

- Click the [X] in the upper right of the window to close the edit window.

For a list of edit window functions, refer to p.82.

Double-click

Double-click

Double-click
Adjusting an Image

You can perform a variety of image adjustments such as brightness adjustment or changing the Picture Style setting using the tool palette in the edit window. With RAW images, you can easily restore an image to its original settings with the [Reset] button even if you have made the wrong adjustment or setting. Try out the various adjustments. As an example, the procedure to adjust the brightness of an image is explained here.

### Tool palette

<table>
<thead>
<tr>
<th>RAW Image adjustment</th>
<th>RGB Image adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness adjustment</td>
<td>Y</td>
</tr>
<tr>
<td>White balance</td>
<td>Y</td>
</tr>
<tr>
<td>Click white balance</td>
<td>N</td>
</tr>
<tr>
<td>Picture Style</td>
<td>Y</td>
</tr>
<tr>
<td>Contrast</td>
<td>Y</td>
</tr>
<tr>
<td>Color tone</td>
<td>Y</td>
</tr>
<tr>
<td>Color saturation</td>
<td>Y</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Y</td>
</tr>
<tr>
<td>Dynamic range</td>
<td>Y</td>
</tr>
<tr>
<td>Automatic adjustment</td>
<td>N</td>
</tr>
<tr>
<td>Tone curve</td>
<td>Y</td>
</tr>
</tbody>
</table>

The image brightness is adjusted in real time according to the amount of adjustments.

- When the tool palette does not display, select the [View] menu ➦ [Tool palette].

With DPP, you can make the following adjustments to a RAW image using the [RAW image adjustment] tool palette and the [RGB image adjustment] tool palette (p.83) in the edit window. The adjustments can be added to the image as a recipe (image processing conditions information).

- Whichever tool palette is used to adjust an image, only the recipe changes and the original "RAW image data" itself remains unaffected.
- When adjusting a RAW image, firstly adjust with the [RAW image adjustment] tool palette and then if further adjustment is required, use the [RGB image adjustment] tool palette.
Saving an Image

If you perform the save operation described here, you can save your adjustments in the RAW image as a recipe (image processing conditions information). As an example, the procedure to add and save a recipe to an image is described here.

Select the [File] menu ➤ [Add recipe and save].

- **Add recipe and save**  
  - Ctrl+S
- **Add recipe and save as**  
  - Ctrl+Shift+S
- **Convert and save**  
  - Ctrl+H

- **Print...**  
  - Ctrl+P
- **Print with detailed settings...**  
  - Ctrl+Alt+P
- **Contact Sheet Prints...**  
  - Ctrl+Shift+P
- **Plug-in printing**

- **Info**  
  - Ctrl+I
- **Close**  
  - Ctrl+W

Your adjustments are saved to the image.

With DPP, images can be saved in the following ways.

- **Add recipe and save** *(p.28)*  
  Add adjustments (recipe) to an original RAW image and save.
- **Add recipe and save as** *(p.28)*  
  Add adjustments (recipe) to an original RAW image and save as a separate RAW image. The original RAW image remains unaffected.
- **Add thumbnail to image and save** *(p.17)*  
  Create a new thumbnail image for the main window and save to each image.
  The quality of images in the main window improves and images redraw themselves more quickly.
- **Convert and save** *(p.29)*  
  Convert adjusted RAW image to a JPEG or TIFF image and save.
  The original RAW image remains unaffected.
- **Batch process** *(p.59)*  
  Convert in batches adjusted multiple RAW images to JPEG or TIFF images and save.
  The original RAW images remain unaffected.

You can save * in the main window.

A “Recipe” is the image processing conditions information adjusted with the tool palette in the edit window.
Printing an Image

You can print images with a printer. As an example, the procedure to print one image on one sheet of paper is described here.

1 Select the [File] menu ➤ [Print].

2 Specify the optimum settings for photograph printing in the printer’s print settings dialog box and click the [OK] button. ➔ Printing begins.

With DPP, you can perform the following types of printing:

- Print one image (p.33)
- Print with a PIXMA/BJ printer (p.30, p.48)
- Print with shooting information (p.47)
- Contact sheet printing (p.47)

Exiting DPP

In the main window, select the [File] menu ➤ [Exit].

If you have not saved adjusted images, a confirmation dialog box for saving of the images appears. Select [Yes] to save the recipe (the adjustments) to the image (p.28).
Advanced Operation

Describes a more advanced operational flow from efficiently checking multiple images, various ways of editing an image, printing a RAW image with a Canon printer to sorting images.

Efficiently Checking/Sorting Images ........................................ 14
  Sorting Images ........................................................................ 15
    Checking Selected Images Only ............................................. 15
  Classifying Images in the Main Window .................................... 16
  Sorting Images in the Main Window ........................................... 16
  Improving the Quality of an Image in the Main Window .......... 17
  Checking Image Shooting Information ..................................... 17

Editing an Image ..................................................................... 18
  Adjusting Brightness ............................................................... 18
  Changing a Picture Style .......................................................... 19
    Applying a Picture Style File ................................................... 19
  Adjusting Contrast ................................................................. 20
  Changing Color Tone and Color Saturation ............................ 20
    Adjusting Monochrome .......................................................... 21
  Adjusting Sharpness ............................................................... 22
  Changing White Balance ......................................................... 22
  Using Click White Balance ...................................................... 23
  Automatically Adjusting Brightness and Color (Tone Curve Assist) ............................................................................... 24

Editing Efficiently ................................................................. 25
  Trimming an Image ................................................................. 26
  Re-Editing an Image ............................................................... 28
  Saving Editing Results ............................................................ 28

  Adding a Recipe and Save ....................................................... 28
  Saving as a JPEG or TIFF Image .............................................. 29
  Printing an Image .................................................................... 30
    Printing Photographs with Canon PIXMA/BJ Printers .............. 30
    Printing Photographs with a Printer other than the PIXMA/BJ Printers ................................................................. 33

Organizing Images ................................................................. 33
  Deleting an Unwanted Image .................................................... 33
  Creating a Folder for Saving Images ........................................... 34
  Sorting Images ....................................................................... 35
  Sorting Folders ....................................................................... 35
    Downloading CF Card Images from a Card Reader ............... 35
  Registering Frequent-Use Folders (Bookmark Registration) .................. 36
    Organizing Bookmarks .......................................................... 36
Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window and efficiently check each image. You can attach check marks and sort images into three groups.

1. Click the [Select all] button on the toolbar.

   ![Digital Photo Professional - C:Documents and Settings](image)

   The color of the image frame around all the images changes.

2. Display the quick check window.

   - Select the [Tools] menu ➔ [Start Quick check tool].

   ![Quick check window](image)

   - The quick check window appears.

3. Click the [Next] or [Previous] button to switch between images.

   - Displays the image in full screen. To return to the normal screen, press the <Esc> key. Switch between 50% view/full view

   Quick check window

   - When you double-click on the area in the image you want to enlarge, the image is enlarged ([50% view]) centered around the area you double-clicked. Double-click again to revert to the full view.
   - If you have enlarged an image, you can move the display position by dragging the image.
   - To close the window, click the [OK] button.

   ![Quick check window functions](image)

   - The enlargement ratio when you clicked [50% view] button is half the actual pixel width (100%).
   - Each operation can also be performed with the menu which appears when you right-click with the mouse on the image.
   - To switch between full screen display/normal screen display, press the <Alt> + <Enter> keys.
   - When step 2 is performed with no image selected in the main window, you can check in the quick check window all the images that were displayed in the main window.
   - For a list of quick check window functions, refer to p. 84.
**Sorting Images**
You can sort images by attaching three types of check marks for each subject or theme in the quick check window.

**Attaching check marks for sorting in the quick check window.**
- Check mark

![Image](image.png)

- The selected check mark appears in the upper left of the window.
- Click the [Clear] button to remove the check marks.

**Checking Selected Images Only**
You can display images selected in the main window in the quick check window.

**Select multiple images that you want to check in the main window.**
- **Selecting multiple images**
  - Click on images while holding down the <Ctrl> key.
- **Selecting multiple consecutive images**
  - Click on images while holding down the <Shift> key.
Classifying Images in the Main Window

You can classify images by attaching three types of check marks in the main window.

In the main window, select the images you want to classify and attach a check mark for classifying.

→ The selected check mark appears in the upper left of the image frame.
→ Click the [Clear check] button to remove the check marks.

Sorting Images in the Main Window

You can sort images in the main window in the order of the check marks you have attached to images or in the order of date and time at which the images were shot.

Select the [View] menu ▶ [Sort] ▶ desired item.

Check mark

The images are sorted in order according to the selected item.

[Check mark1] - [Check mark3]
Images with check marks are sorted in numerical order.

[Shooting Date/Time]
Images are sorted by shooting date and time from the earliest.

[File name]
Images are sorted by file name in alphanumeric order (0 to 9 → A to Z).

[RAW priority]
Images are sorted in the following order: RAW images → JPEG images → TIFF images

When you have attached check marks 1 to 3, the images are sorted as follows: If you select 1, the order is 1 → 2 → 3; if you select 2, the order is 2 → 1 → 3; if you select 3, the order is 3 → 2 → 1.
Improving the Quality of an Image in the Main Window

Create a new thumbnail image for the main window and save to each image.
The quality of images in the main window improves and images redraw themselves more quickly.

With all the images selected, select the [File] menu ➔ [Add thumbnail to image and save].

- The quality of thumbnail images best improves when [Large thumbnail] (p.8) is selected.
- A large number of images may take some time to add.

1. Select the image for which you want to check the shooting information.
2. Select the [File] menu ➔ [Info].

The image information window appears.
Editing an Image

Below is described how to adjust an image using the tool palette in the edit window. You can easily restore an image to its original condition with the [Reset] button even if you have made the wrong adjustment or setting. Try out the various adjustments.

The image is adjusted in real time according to adjustments performed with the tool palette.

To revert to the condition before the last operation performed on the tool palette, press the <Ctrl> + <Z> keys.

You can rotate an image in the [Adjustment] menu.

To display multiple edit windows, perform the operation to display the edit window (p.9) several times. When multiple edit windows are displayed, you can line them up by selecting the [Window] menu ➔ [Arrange vertically] or [Arrange horizontally].

You can change the way the tool palette is displayed (p.52).

For a list of edit window functions, refer to p.82.

For a list of tool palette functions, refer to p.83.

The adjustment range is –2.0 to +2.0 (in 0.01-stop increments when entering a value).

In the main window, you can also adjust brightness in the [Brightness adjustment] dialog box which appears when you click the [Brightness (RAW)] button (p.80) in the toolbar.
Changing a Picture Style

You can change the settings of a RAW image you have shot to [Standard], [Portrait], [Landscape], [Neutral], [Faithful] or [Monochrome]. Simply select the desired Picture Style and its settings are reflected in an image. If you change a RAW image to monochrome and save it, you can revert to the original colors of the image by clicking the [Reset] button of the Picture Style.

In DPP, even if you change the Picture Style, the [Contrast], [Color tone], [Color saturation] and [Sharpness] settings do not change. Change each one as necessary.

**Applications of Picture Style**

**Standard**
The image looks vivid. Ordinarily, this setting is suitable for most images.

**Portrait**
For nice skin tones. Effective for close-ups of women and children. By changing the [Color tone], you can adjust the skin tone (p.20).

**Landscape**
For vivid blues and greens. Effective for making images of landscapes impressive.

**Neutral**
For natural colors and subdued images. Effective for base images which are to undergo adjustment.

**Faithful**
When the subject is photographed under a color temperature of 5200K, the color is adjusted colorimetrically to match the subject’s color. Effective for base images which are to undergo adjustment.

**Monochrome**
For black and white images. You can also adjust with [Filter effect] or [Toning effect] (p.21).

(Picture Style file registered in the camera)
Displayed when selecting an image shot with the Picture Style file registered in the camera. In the list, the caption name of the Picture Style file registered in the camera is displayed in ( ).

[Loaded Picture Style file]
The caption name of the Picture Style file downloaded from Canon's web site and loaded by clicking the [Browse] button is displayed in [ ].

Applying a Picture Style File

You can apply Picture Style files downloaded from Canon's web site. Click the [Browse] button and in the window that appears, select a downloaded Picture Style file. The Picture Style file you selected is applied to an image.

[Contrast], [Color tone], [Color saturation] and [Sharpness] set for each Picture Style item can be memorized for each image (p.52).
**Adjusting Contrast**

Contrast can be used to adjust modulation and degree of contrast of color. Move the slider to the right to make contrast stronger and to the left to make contrast weaker.

If [Linear] is check-marked, a dim image is displayed. Use for performing individual detailed image adjustment and performing different adjustments with image editing software that has advanced editing functions.

The adjustment range is –4 to +4 (in 1-stop increments).

**Changing Color Tone and Color Saturation**

Skin tone and overall color saturation can be adjusted. If Picture Style is set to [Monochrome] (p.21), [Color tone] and [Color saturation] switch to [Filter effect] and [Toning effect].

- **Color tone:** Mainly used for adjusting skin tones. Move the slider to the right to make skin tones more yellow, and to the left to make skin tones redder.

- **Color saturation:** The overall color depth of the image is adjusted with color saturation. Move the slider to the right to make the color deeper, and to the left to make the color weaker.
Adjusting Monochrome

You can create monochrome photographs with effects similar to filtering and with the look of a single-color photograph.


2. Drag the sliders left or right.

- **Filter effect:** Creates an image where the white of clouds and the green of trees are emphasized in the same monochrome photograph.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Example of effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Ordinary monochrome image without filter effect.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Blue sky is reproduced more naturally and white clouds emerge clearly.</td>
</tr>
<tr>
<td>Orange</td>
<td>Blue sky becomes somewhat darker. The brightness of the setting sun increases further.</td>
</tr>
<tr>
<td>Red</td>
<td>Blue sky becomes quite dark. Autumn leaves become clear and bright.</td>
</tr>
<tr>
<td>Green</td>
<td>Human skin tones and lips become softer. The green leaves of trees become clear and bright.</td>
</tr>
</tbody>
</table>

- **Toning effect:** You can create a single-color monochrome photograph to which color has been added. You can choose from [None], [Sepia], [Blue], [Purple] and [Green].

If the [Contrast] (p.20) slider is set to the right, the filter effect is emphasized even more.
Adjusting Sharpness
You can make the overall atmosphere of an image softer or harder. Move the slider to the right to make an image harder and to the left to make an image softer.

Changing White Balance
If the color tone of the photographed image does not appear natural, adjust the white balance. You can make the color tone natural by setting the light source at the time of shooting an image of, for example, pale-colored flowers.

The adjustment range is 0 to 10 (in 1-stop increments).
Using Click White Balance

You can adjust white balance by making a selected part of an image the standard for white. Using click white balance is effective when using it in parts of an image where white color tone has changed under the influence of a light source.

1. **RAW image adjustment**
   - White balance adjustment
     - **Click**
     - **Reset**

2. Click on a point that is to be the standard for white.

   - Displays the coordinates of the cursor position and the RGB values (8-bit conversion).
   - Reverts the image to the original settings.

   The color of the image is adjusted with the point you selected as the standard for white.
   - If you click on another point in the image, the white balance is adjusted again.
   - To finish click white balance, click the right button on the mouse or click the [Click] button.

   - The image is adjusted based on the average value of a 5 × 5 pixel range from the clicked point.
   - Even if you have selected a neutral gray point in an image, the result of adjustment is the same as when you select a white point.
   - In the main window, you can also use click white balance by clicking the [Click (RAW)] button (p.80) in the toolbar.
Automatically Adjusting Brightness and Color (Tone Curve Assist)

[Brightness] and [Color] are automatically adjusted to create a desirable standard image. The degree of automatic adjustment can be selected from [Standard] or [High].

Click on the [RGB image adjustment] tab sheet and click the desired automatic adjustment button.

- Standard: Standard automatic adjustment. Suitable for most images.
- High: Use when the effect achieved in standard automatic adjustment is not strong enough.

If you click the button, the tone curve as well as the [Color tone] and [Color saturation] of the [RGB image adjustment] tool palette revert to the default settings. Take care when adjusting the [Color tone] and [Color saturation] individually.

Automatic adjustment (tone curve assist) is a function for adjusting the brightness and color by automatically adjusting the tone curve (brightness and color saturation of an image before and after adjustment in the form of a graph) of an image. The adjustment result may not be as expected with the following images:

- Images which have been shot with the proper exposure
- Images where the brightness is unbalanced
- Images which are too dark
- Images which have extreme backlighting

In the main window, you can also adjust the tone curve by selecting the [Adjustment] menu [Tone Curve Assist - Standard] or [Tone Curve Assist - High].

The tone curve changes as adjusted.
Editing Efficiently

The thumbnail display and the edit window are combined and images can be edited efficiently while quickly switching between images to be edited. Images to be edited are selected beforehand in the main window.

1. In the main window, select the images you want to edit.
2. Switch to the edit image window.
   - The main window switches to the edit image window.
3. Edit in the edit image window.
   - Select the image to be edited.
   - It may take time for the image to redraw itself.

Click to switch back to the main window.
Change the size.

- The tool palette has the same content as the edit window.
- To revert to the condition before the last operation performed on the tool palette, press the <Ctrl> + <Z> keys.
- Double-click on the position you want to enlarge and the image is displayed enlarged at [100% view] (actual pixel size). Double-click again to return to the full view ([Fit to window]).
- When you have displayed an enlarged image, you can change the display position by dragging the image.
- If you want to arrange sideways the thumbnail display position as shown below, select the [View] menu ▶ [Change thumbnail position].
- Double-click on the image in [50% view], [100% view] or [200% view] to change to the full view ([Fit to window]).
- You can change the way the tool palette is displayed (p.52).
- For a list of edit image window functions, refer to p.85.
Trimming an Image

You can trim and enlarge only the part of an image you need, or change the composition of an image where an image shot horizontally becomes vertical. The trimmed image becomes a trimmed image when converted to JPEG or TIFF image and saved (p.29).

1 Select the image to be trimmed.

2 Open the trimming window.
   ● Select the [Tools] menu ▶ [Start Trimming tool].

3 When the image has redrawn itself, select a ratio and trim.

   **Trimming window**

   - The trimmed range can be moved by dragging.
   - You can enlarge or reduce the size of the trimmed range by dragging the four corners of the trimmed range.
   - List of aspect ratios (width : height)

<table>
<thead>
<tr>
<th>[Free]</th>
<th>[Custom]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1</td>
<td>A Size Landscape</td>
</tr>
<tr>
<td>3:2</td>
<td>A Size Portrait</td>
</tr>
<tr>
<td>2:3</td>
<td>Letter Landscape</td>
</tr>
<tr>
<td>4:3</td>
<td>Letter Portrait</td>
</tr>
<tr>
<td>3:4</td>
<td>Custom</td>
</tr>
<tr>
<td>5:4</td>
<td></td>
</tr>
<tr>
<td>4:5</td>
<td></td>
</tr>
</tbody>
</table>

4 Click the [OK] button to return to the main window.
   → The [ ] mark (p.81) appears in the trimmed image.

5 Convert and save the trimmed image as a separate image.
   ● The trimmed image becomes a separate trimmed image when converted to a JPEG or TIFF image and saved (p.29).

   ![Trimming window](image.png)

   - Cancel
   - Select a trimming ratio.
   - Drag the trimming range.
The image does not become a trimmed image by performing “Adding a Recipe and Save” (p.28). You must convert to a JPEG or TIFF image and save it (p.29).

If you print a trimmed image without converting and saving with Easy-PhotoPrint (p.30), the untrimmed image is printed. Convert to a JPEG or TIFF image and save before printing (p.29).

Changes are not saved to a trimmed image, merely information about the trimmed range is saved in the image. For that reason, you can return an image to its original condition at any time (p.28).

Each operation can also be performed with the menu which appears when you right-click with the mouse on the image.

To switch between full screen display/normal screen display, press the <F11> key or the <Alt> + <Enter> keys.

You can also press the <Esc> key to return the full screen display to the normal screen display.

If you have clicked [Apply All], the trimming range you have copied is applied to all images selected when the trimming window is displayed.

* Operates when you have selected multiple images and the trimming window is displayed.

If [Free] has been selected in the [Aspect ratio] list box, you can also drag the borders of the trimmed range to change its range.

To apply the same trimming range to multiple images, use the [Copy], [Paste] and [Apply All] buttons.
Re-Editing an Image

Since only the image processing conditions of an edited RAW image is changed and displayed, the original image data itself remains unaffected in its original condition. For that reason, you can cancel all adjustments in an image and restore it to the last saved condition or to the image that you originally shot.

1. Select the image that is to be re-edited.

2. Select the [Adjustment] menu ▶ desired item.

<table>
<thead>
<tr>
<th>Adjustment</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate Left</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Rotate Right</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Add check mark 1</td>
<td>Alt+1</td>
</tr>
<tr>
<td>Add check mark 2</td>
<td>Alt+2</td>
</tr>
<tr>
<td>Add check mark 3</td>
<td>Alt+3</td>
</tr>
<tr>
<td>Remove check mark</td>
<td>Alt+Z</td>
</tr>
<tr>
<td>Apply Dust Delete Data</td>
<td></td>
</tr>
<tr>
<td>White Balance</td>
<td></td>
</tr>
<tr>
<td>Brightness adjustment (RAW)</td>
<td></td>
</tr>
<tr>
<td>Brightness adjustment</td>
<td></td>
</tr>
<tr>
<td>Work color space</td>
<td></td>
</tr>
<tr>
<td>Tone Curve Assist - Standard</td>
<td></td>
</tr>
<tr>
<td>Tone Curve Assist - High</td>
<td></td>
</tr>
<tr>
<td>Revert to last saved settings</td>
<td>Ctrl+Alt+Z</td>
</tr>
<tr>
<td>Revert to shot settings</td>
<td>Ctrl+Shift+Z</td>
</tr>
</tbody>
</table>

- The image reverts to the conditions of the selected item.

Saving Editing Results

Adding a Recipe and Save

You can save contents adjusted using the tool palette as a recipe (image processing conditions information) to an image.

1. Select the [File] menu ▶ desired item.

2. Your adjustments are saved to the image.

As with RAW images, edited JPEG or TIFF images (p.62) can also be reverted at any time to their original condition with the operation on this page.
Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP, convert to a more versatile JPEG or TIFF image. An image that has been trimmed (p.26) or that has had dust erased (p.43, p.44, p.46) becomes a trimmed image or a dust-erased image when converted to a JPEG or TIFF image and saved. The RAW image remains unaffected.

1. Select the image to be converted.
2. Select [File] menu ➔ [Convert and save].
   - Select the save destination.
   - Click and save
   - Enter a file name and select an image type.
   - The RAW image is converted and the JPEG or TIFF image is saved as a new image in the specified save destination.

3. Specify the necessary settings, and then click the [Save] button.
   - By default, the image is converted and saved to a JPEG image with the highest image quality, without changing the image size. Change the settings according to your requirements.

   - A trimmed (p.70) or dust-erased (p.72, p.73, p.75) JPEG or TIFF image can be saved as a separate trimmed image or dust-erased image by following the operation on this page.
   - For a list of [Save As] window functions, refer to p.86.
Printing an Image

This section explains how to print high-resolution photographs easily with the PIXMA/BJ printers compatible with the Canon printing software, Easy-PhotoPrint. It also explains how to print photographs using other printers.

**Printing Photographs with Canon PIXMA/BJ Printers**

You can perform the following types of photograph printing with the PIXMA/BJ printers compatible with the Easy-PhotoPrint:

- Simple printing of RAW images
- Printing with faithful colors
- High quality printing using the color reproduction range of Adobe RGB and a PIXMA printer

To perform this printing, it is necessary to first install Easy-PhotoPrint version 2.1 or later on your computer.

1. Select the image to be printed.
2. Start up Easy-PhotoPrint.
   - Select the [File] menu → [Plug-in printing] → [Print with Easy-PhotoPrint].

   - > Easy-PhotoPrint starts up.
3 In the Easy-PhotoPrint window, select the [File] menu ▶ [Preferences].

→ The [Preferences] window appears.

4 Select [Quality Priority] in [Print Quality].

5 Select the [Advanced] tab sheet and cancel the Easy-PhotoPrint image compensation function.

6 In the [2 Paper Selection] tab sheet, cancel the image compensation function and select the paper type.
7 In the [3 Layout/Print] tab sheet, specify the layout and click the [Print] button.

Click to print.

Select the layout.

→ Printing begins.

If you print a trimmed (p.26) image without converting and saving, the untrimmed image is printed. Convert to a JPEG or TIFF image and save before printing (p.29).

- Printing with faithful colors
  You can print faithful colors with images that have sRGB or Adobe RGB color space set (p.46, p.53).

- Printing with a wide color reproduction
  If you set the color space (p.46, p.53) to Adobe RGB and print with the PIXMA printer, the color reproduction area widens, and green and blue in particular are reproduced vividly.

- You can print up to 1000 images selected in DPP at a time.
- If you are not satisfied with the color of a printed photograph, change the matching method to [Perceptual] (p.53, p.54).
- DPP is also compatible for printing with Easy-PhotoPrint Pro (p.48).
Printing Photographs with a Printer other than the PIXMA/BJ Printers

You can print one image on one sheet of paper.

1. Select the image to be printed.
2. Select the [File] menu ▶ [Print].
   - The printer’s print settings dialog box appears.
3. Set to photograph printing and print.
   - Specify the optimum settings for photograph printing in the printer’s print settings dialog box and click the [OK] button.
   - Printing begins.

Organizing Images

This section explains how to delete unwanted images, create folders for saving images, copy or move images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

1. Select an unwanted image in the main window.
2. Select the [File] menu ▶ [Delete].
   - The [Confirm File Delete] dialog box appears.
3. Click the [OK] button.
   - The image is moved to the [Recycle Bin] and is deleted from DPP.
   - The images are deleted completely when the [Empty Recycle Bin] operation is performed on the [Recycle Bin] on the desktop.

! If you selected multiple images, they are all deleted. Take particular care when you have just completed a task involving selection of multiple images.
Creating a Folder for Saving Images

You can create a folder for sorting images.

1. In the folder area, select the location where the new folder is to be created.

2. Select the [File] menu » [Create new folder].

   ![Image showing the file menu]

   > The [Create new folder] dialog box appears.

3. Enter a folder name and click the [OK] button.
   > The new folder is created in the folder selected in step 1.
Sorting Images
You can move or copy images to a separate folder and sort by shooting date or themes.

Drag the image to be copied or moved.

The images are copied or moved to the destination folder.

- **To copy**: Drag the image while holding down the <Ctrl> key and release when the image is in the required folder.
- **To move**: Drag the image and release when the image is in the required folder.

Sorting Folders
You can move or copy folders to a separate folder and sort them.

*Drag the folder to be copied or moved.*

- The folders are copied or moved to the destination folder.
- **To copy**: Drag the folder while holding down the <Ctrl> key and release when the folder is in the required folder.
- **To move**: Drag the folder and release when the folder is in the required folder.

Downloading CF Card Images from a Card Reader
In the explanation window above, open [My Computer] ➤ [Removable disk] and move the [DCIM] folder inside to a suitable place such as to the desktop. The [DCIM] folder and the images inside are downloaded to your computer.
Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders as bookmarks. Registered folders appear by clicking the [Bookmark] menu.

1 Select the folder for which a bookmark is to be registered.

2 Select the [Bookmark] menu ▶ [Add].

Organizing Bookmarks

You can change a folder name or delete a folder registered in [Bookmark].

Select the [Bookmark] menu ▶ [Organize].

The [Sort bookmarks] window appears and you can change folder names or delete folders.

You can register frequently used folders as bookmarks. Registered folders appear by clicking the [Bookmark] menu.

1. Select the folder for which a bookmark is to be registered.
2. Select the [Bookmark] menu ▶ [Add].

Selecting Frequent-Use Folders (Bookmark Registration)

You can change a folder name or delete a folder registered in [Bookmark].

Select the [Bookmark] menu ▶ [Organize].

The [Sort bookmarks] window appears and you can change folder names or delete folders.

You can register frequently used folders as bookmarks. Registered folders appear by clicking the [Bookmark] menu.

1. Select the folder for which a bookmark is to be registered.
2. Select the [Bookmark] menu ▶ [Add].

Organizing Bookmarks

You can change a folder name or delete a folder registered in [Bookmark].

Select the [Bookmark] menu ▶ [Organize].

The [Sort bookmarks] window appears and you can change folder names or delete folders.
Various preferences including advanced image editing, automatic dust erasure processing, various printing functions for printing out work, and color management are explained here, geared to the user who is a professional competent in the handling of commercial image editing software.

Editing While Comparing with the Original Image ............................................ 38
  Changing How the Window is Split .................................................................. 38
Performing Advanced Editing .............................................................................. 39
  Adjusting White Balance with Color Temperature .................................. 39
  Adjusting White Balance with Color Wheel ............................................. 39
  Adjusting Dynamic Range .......................................................................... 40
  Tone Curve Adjustment .............................................................................. 41
    Example of a Tone Curve Operation .............................................................. 42
    [RGB image adjustment] Tool Palette Functions ........................................ 42
Performing Automatic Dust Erasure Processing .............................................. 43
  Automatic Dust Erasure Processing in the Main Window ....................... 43
Manually Erasing Dust (Repair Function) ....................................................... 44
  Erasing Unwanted Parts of an Image (Copy Stamp Function)...................... 46
Transferring a RAW Image to Photoshop ....................................................... 46
Setting Work Color Space ............................................................................ 46
Printing with Shooting Information .............................................................. 47
Printing a Thumbnail List (Contact Sheet Printing) ...................................... 47

Printing RAW Images on a High-End Canon Printer .................................. 48
  Printing with a PIXMA Printer .................................................................... 48
  Printing with a Large-Format Canon Printer ............................................. 49
Specifying Preferences .................................................................................... 49
  General Settings ....................................................................................... 50
  View Settings .......................................................................................... 51
  Tool Palette ............................................................................................. 52
  Color Management .................................................................................. 53
Editing While Comparing with the Original Image

You can display before and after versions of an adjusted image in the same window and edit while checking the adjustment results.

1. In the edit window, select the [View] menu ➔ [Before/after comparison].
   ➔ The image divides into a left and right window.

   ![Image](image1.png)

   ➔ The window on the right shows the image after editing.

2. Change the image display.
   • Select the [View] menu ➔ [Change up/down/left/right].
     ➔ The arrangement of the two images changes to top and bottom.

   ![Image](image2.png)

   ➔ The bottom window shows the image after editing.

Images can also be displayed in the edit image window by the same operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

1. Select the [Tools] menu ➔ [Preferences].

2. Select the [View settings] tab sheet.

3. Select [Split single image and show] from [Before/after comparison] and click the [OK] button.
   ➔ One image is divided and displayed on the left and right or top and bottom.

   ![Image](image3.png)

   ➔ To switch between top and bottom, and left and right, perform the same operation as step 2 on the left page.
Performing Advanced Editing

This section explains how to use the advanced editing function on the tool palette in the edit window.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color temperature.

Select [Color temperature] from the [White balance adjustment] list box.

Drag the slider left or right.

Enter the values to set.

The adjustment range is 2800 to 10,000K (in 100K units).

In the main window, you can also adjust white balance in the [White balance adjustment] dialog box which appears when you click the [White balance] button (p.80) in the toolbar.

The adjustment range of color tone is 0 to 359 (1 unit in numerical value input), and the adjustment range of color saturation is 0 to 255 (1 unit in numerical value input).

In the main window, you can also adjust white balance in the [White balance adjustment] dialog box which appears when you click the [White balance] button (p.80) in the toolbar.
The dynamic range (width of gradation expression) from dark points to bright points in an image can be adjusted. The more the shadow point is towards the right, the more the gradation of dark points in the image disappears and the image becomes darker. The more the highlight point is towards the left, the more the gradation of bright points in the image disappears and the image becomes brighter. The narrower the space between shadow point and highlight point becomes, the narrower the gradation from bright points to dark points of an image becomes.

**Adjusting Dynamic Range**

Drag the slider to the left to set highlight points.

Drag the slider to the right to set shadow points.
Tone Curve Adjustment
You can adjust the brightness, contrast and color of a specific area by changing the tone curve.

1. In the tool palette, select the [RGB image adjustment] tab sheet.

2. Select the tone curve mode and interpolation method.

3. Make adjustments.

- The horizontal axis shows the input level and the vertical axis shows the output level.
- The maximum number of [ ] is 8.
- To delete a [ ], either press the <Del> key or double-click on the [ ].

Right-click with the mouse inside the graph to display the menu.

Batch adjusts RGB.

Click to add a [ ] (point). Adjust by dragging [ ].

Adjust each channel.

The histogram display changes according to adjustment. You can also fix the histogram display to the display before any adjustments (p.52).

The tone curve mode and interpolation method for a tone curve can also be changed in [Preferences] (p.52).
Example of a Tone Curve Operation

Makes medium tones brighter  Makes medium tones darker

[RGB image adjustment] Tool Palette Functions

The [RGB image adjustment] tool palette has the following functions. Its operating method is explained in detail in Chapter 5.

- Click white balance
- Dynamic range adjustment
- Color tone, color saturation and sharpness adjustment

The [RAW image adjustment] tool palette has the same functions as above, so use of the following [RAW image adjustment] tool palette functions are recommended for adjusting RAW images.

- “Using Click White Balance” (p.23)
- “Adjusting Dynamic Range” (p.40)
- “Changing Color Tone and Color Saturation” (p.20)
- “Adjusting Sharpness” (p.22)
Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera that can attach this data, can be used to automatically erase dust spots. The dust-erased image becomes a dust-erased image when converted to a JPEG or TIFF image and saved (p.29).

1. In the main window, select an image appended with Dust Delete Data.

2. Select the [Tools] menu ▶ [Start Stamp tool].
   → The copy stamp window appears.

3. When the image has redrawn itself, click the [Apply Dust Delete Data] button.

Copy stamp window

4. Click the [OK] button to return to the main window.
   → The [塵除] mark (p.81) is displayed on an image from which dust spots have been erased.

5. Convert and save as a separate image.
   - The image becomes a dust-erased image by converting and saving as a JPEG or TIFF image (p.29).

   ! Even if you have saved by performing “Adding a Recipe and Save” (p.28), a dust-erased image is not created, merely information about dust erasure processing is saved to an image. You must convert to a JPEG or TIFF image and save it (p.29).

   - A dust-erased image does not change, merely dust erasure information is saved to the image. For that reason, you can return an image to its original condition at any time (p.28).
   - Check dust-erased images in the copy stamp window. You cannot check them in other windows.
   - In automatic dust erasure processing, dust spots are erased based on information relating to dust saved in the Dust Delete Data. However, there may be cases where you will not be able to erase dust spots depending on the type of dust. If this occurs, erase those dust spots using the repair function (p.44) or the copy stamp function (p.46).
   - To switch between full screen display/normal screen display, press the <F11> key or the <Alt> + <Enter> keys.
   - You can also press the <Esc> key to return the full screen display to the normal screen display.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in an image appended with Dust Delete Data.

Select an image appended with Dust Delete Data, and then select the [Adjustment] menu ▶ [Apply Dust Delete Data].
   → Dust spots in the selected image are erased in a single operation.
Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. The dust-erased image becomes a dust-erased image when converted to a JPEG or TIFF image and saved (p.29).

1. In the main window, select the image you want to erase dust spots.
2. Select the [Tools] menu ▶ [Start Stamp tool].
   → The copy stamp window appears.
3. When the image has redrawn itself, double-click the point from where dust is to be erased.
4. Click the button that matches the dust spot to be erased.
   - If the dust spot is dark in color, click the [ ] button, and if the dust spot is light in color, click the [ ] button.
   - When you move the cursor over the image, the dust erasure range appears as [ ].
5. Place the dust spot to be erased within the [ ] and click.
   → The display changes to 100% view.
   - The display position can be changed by dragging.
   - You can also change the display to 100% view by clicking the [100% view] button.
6. Click the [OK] button to return to the main window.
   → The [ ] mark (p.81) is displayed on an image from which dust spots have been erased.
7. Convert and save as a separate image.
   - The image becomes a dust-erased image by converting to a JPEG or TIFF image and saving (p.29).
You can apply the dust erasure in the same place in multiple images using the [Copy] and [Paste] buttons.

Even if you have saved by performing “Adding a Recipe and Save” (p.28), a dust-erased image is not created, merely information about dust erasure processing is saved to an image. You must convert to a JPEG or TIFF image and save it (p.29).

A dust-erased image does not change, merely dust erasure information is saved to the image. For that reason, you can return an image to its original condition at any time (p.28).

Check dust-erased images in the copy stamp window. You cannot check them in other windows.

[Radius] that sets the dust erasure range can be set in a range of 5 to 100 (in one pixel units).

Spots of dust can be erased with the repair function. There may be cases where you will not be able to erase lines of dust. If this occurs, erase the dust with the copy stamp function (p.46).

When you have erased several dust spots in an image, press the <Shift + B> keys to display the previous dust-erased spot and the <Shift + F> keys to display the next dust-erased spot successively. Also, the dust-erased spots are automatically recorded. For this reason, you can display in order the same dust-erased spots as the dust-erased image when switching to another image and pressing the <Ctrl + F> or <Ctrl + B> keys.

To switch between full screen display/normal screen display, press the <F11> key or the <Alt> + <Enter> keys.

You can also press the <Esc> key to return the full screen display to the normal screen display.
Erasing Unwanted Parts of an Image (Copy Stamp Function)
You can correct an image by pasting a section of an image copied from another part of the image to an unwanted part of the image. The corrected image becomes a corrected image by converting to a JPEG or TIFF image and saving (p.29).

1 Follow steps 1 to 3 in “Manually Erasing Dust (Repair Function)” (p.44).

2 Specify the section to be copied.
- Click the [Select Copy Source] button and then click on the section that is to be the copy source.
- To change the section that is to be the copy source, perform the operation above again.
- You can also specify the section to be copied by clicking on the section to be copied while holding down the <Alt> key.
- To fix the position of the copy source, check mark the [Fix Copy Source position].

3 Correct the image.
- Click or drag on the section you want to correct on the image. [+] in the window indicates the copy source and [O] indicates the copy destination.
- The copied image is pasted in the position to which it was dragged.
- For [Pen type], you can select from [Brush] (the pasted image’s borders simulate a brush) and [Pencil] (the pasted image’s borders are sharp).
- Continue by performing the same operations as steps 6 and 7 of “Manually Erasing Dust (Repair Function)” (p.44).

Transferring a RAW Image to Photoshop
A RAW image can be converted to a TIFF 16bit image and transferred to Photoshop.

Select the [Tools] menu ▶ [Transfer to Photoshop].
- Photoshop starts up and the transferred image is displayed.

Setting Work Color Space
A different work color space from the default settings (p.53) can be set for each RAW image.

Select the [Adjustment] menu ▶ [Work color space] ▶ color space to be set.

- Since only the image processing conditions information changes, the color space of a RAW image can be freely changed at any time.
- When you set a color space different from the default setting and change the default setting color space (p.53), the setting is not applied to the image. Change the setting for each image following the operation above.
Printing with Shooting Information
You can freely lay out one image on one sheet of paper and print together with titles and shooting information etc.

1. Select one image to be printed.
2. Select the [File] menu ▶ [Print with detailed setting].
3. Specify the required settings for printing, and then click the [Print] button.

- An image can be moved by dragging.
- Drag the four corners of the image to change the size.
- For the shooting information, click [ ] on the [Text] tab sheet and select the necessary items in the window that is displayed.

- You can print one image selected with DPP.
- You can set printer profiles (p.53, p.54).
- If CMYK simulation has been set, the image is printed in the set colors (p.53, p.54).
- The settings performed in step 3 are memorized by clicking the [Apply] button (not including the settings in the [Text] tab sheet).

Printing a Thumbnail List (Contact Sheet Printing)
You can print rows of multiple images on one sheet of paper.

1. Select images to be printed in a thumbnail list.
2. Select the [File] menu ▶ [Contact Sheet Prints].
3. Specify the required settings for printing, and then click the [Print] button.

- You can print one image selected with DPP.
- You can set printer profiles (p.53, p.54).
- If CMYK simulation has been set, the image is printed in the set colors (p.53, p.54).
- The settings performed in step 3 are memorized by clicking the [Apply] button (not including the settings in the [Text] tab sheet).
Printing RAW Images on a High-End Canon Printer

Printing with a PIXMA Printer
For Canon PIXMA printers that are compatible with the printing software Easy-PhotoPrint Pro, you can print with DPP by a simple operation that has the following features:
- Simple printing of RAW images
- Printing in faithful color
- High quality printing using a wide color space of Adobe RGB etc. and the wide area color reproduction range of a PIXMA printer
To print with DPP, first install Easy-PhotoPrint Pro version 1.0 or later on your computer.

1. Select the [File] menu  [Plug-in printing]  [Print with Easy-PhotoPrint Pro].
   → Easy-PhotoPrint Pro starts up.
2. Specify the required settings for printing, and then print.

- You can print up to 1000 images selected in DPP at a time.
- The specified output resolution (p.50, p.51), trimming (p.26) and CMYK simulation (p.53, p.54) are not applied.
- When a color space (p.46, p.53) with a wider color space than sRGB, such as Adobe RGB is set, the color reproduction range of the PIXMA printer is fully utilized and the image is printed with wider color gamut than the image that has sRGB color space set, and with faithful colors.
Printing with a Large-Format Canon Printer

You can use DPP to print with the Canon large-format imagePROGRAF iPF F5000 printer. To print with DPP, first install the imagePROGRAF Print Plug-in version 2.0 or later on your computer.

1. Select the [File] menu ➤ [Plug-in printing] ➤ [iPF5000 Print Plug-In].
   - The imagePROGRAF Print Plug-in starts up.

2. Specify the required settings for printing, and then print.

---

Specifying Preferences

You can change the various functions of DPP in the Preferences window.

Check the contents of each window and set.

There are detailed contents for items in [General settings] (p.50), [Tool palette] (p.52) and [Color management] (p.53).

1. Select the [Tools] menu ➤ [Preferences].
   - The [Preferences] window appears.

2. Select the tab sheet, specify the settings, and then click the [OK] button.

---

- You can print one image selected with DPP.
- Specified output resolution (p.50, p.51) and CMYK simulation (p.53, p.54) are not applied.
- When a color space (p.46, p.53) with a wider color space than sRGB, such as Adobe RGB is set, the color reproduction range of the imagePROGRAF iPF F5000 printer is fully utilized and the image is printed with wider color gamut than the image that has sRGB color space set, and with faithful colors.
General Settings

Basic preferences such as specifying the folder that opens when DPP is started, the image quality of displayed RAW images/image quality of RAW images when converted and saved, and whether noise reduction is enabled or disabled can be specified.

- **Operating mode**
  You can select from three types of combination of image quality when a RAW image is displayed and when a RAW image is converted to a JPEG or TIFF image and saved (p.29, p.59).

  - **[Quality priority]**
    Since noise (false color, luminance noise, chrominance noise) undergoes reduction processing when a RAW image is displayed or when an image is converted and saved, image quality is high. However, it takes more time to display an image or convert and save an image.

  - **[Standard]**
    Because noise (false color, luminance noise, chrominance noise) does not undergo reduction processing in the display of a RAW image, the speed at which an image is displayed is improved when compared to [Quality priority]. When an image is converted and saved, noise reduction processing is performed as in [Quality priority].

  - **[Speed priority]**
    Noise (false color, luminance noise, chrominance noise) does not undergo reduction processing when a RAW image is displayed and when an image is converted and saved. For this reason, the speed at which an image is displayed and the speed at which an image is converted and saved increases.

- **Noise reduction settings of operating mode**
  The noise in a RAW image shot at night or at a high ISO speed can be reduced. If noise reduction has been set, and [Quality priority] has been selected in [Operating mode], the results of noise reduction can be checked on screen.

  If [Reduce luminance noise] has been set, resolution may be reduced along with reduction of noise, and if [Reduce chrominance noise] has been set, color bleeding may occur.
Chrominance noise reduction setting (except RAW)
The noise in a JPEG image shot at night or at a high ISO speed can be reduced. If noise reduction has been set, and [Quality priority] has been selected in [Operating mode], the results of noise reduction can be checked on screen.

If noise reduction is set, the color bleeding may occur along with the noise reduction.

Default value for output resolution
You can set the resolution for RAW images converted and saved as JPEG or TIFF images (p.29, p.59).

---

View Settings
You can specify preferences relating to the display, such as the image display format (p.38) for before and after editing comparison.
Tool Palette
You can specify preferences for the tool palette of the edit window or edit image window.

- **Default settings of RGB tone curve**
  When the setting is changed, the setting will be applied when DPP is restarted.
  Changes are not applied to images with the [RGB] mark (p.81). Change each one individually (p.41, p.67).

- **Modified Picture Style settings**
  [Contrast], [Color tone], [Color saturation], and [Sharpness] set for each Picture Style item can be memorized for each image.
Color Management

Preferences relating to color management, such as settings for work color space, conditions for rendering intent etc. can be specified.

- **Default settings of work color space**
  You can select from five types of color space (p.89) that is applied as a default setting in RAW images. Color space that has been set is applied as the color space when a RAW image is converted and saved (p.29, p.59) or printed (p.12, p.30, p.33, p.47, p.48, p.49).
  - If you have changed the setting, and you restart DPP, the new setting is applied as the default setting color space.
  - You can check color space that has been set in an image in the edit window (p.82) and the edit image window (p.85).

- **Even if the default setting for the color space is changed, the color space of images that have recipes attached to them are not changed. Change each one individually (p.46).**

- **You can set a color space that is different from default settings for each image (p.46).**

- **Even if the default setting of work color space is changed, the color space of images that have recipes attached to them are not changed. Change each one individually (p.46).**

- **Display setting (color setting of the monitor)**
  Where a profile (p.88) is attached to the monitor you are using, you can display an image in more accurate colors by setting the profile.
  - Check mark the [Monitor profile], click the [Browse] button and in the dialog box that appears, select a profile for your monitor.
  - If you use a profile created using a third party monitor color reader, images can be displayed in even more precise colors.
● Printing profile (color setting of the printer)
Where a profile (p.88) is attached to the printer you are using to print images, you can print an image and simulate the colors displayed on screen by setting the profile. The profile that has been set is applied to all printing (p.12, p.33, p.47) except for linked printing (p.30, p.48, p.49).

- Do not set the image adjustment function of the printer driver. The image may print in colors which are different from the colors in which the image is displayed.
- If you are printing with a Canon inkjet printer, a profile is set automatically and you can easily print in faithful colors (p.30, p.48, p.49).

● Setting of CMYK simulation profiles
You can select the color when printing in the CMYK environment of a printer etc. from four types of profiles (p.89) and perform simulation on screen.
- When CMYK simulation has been set, [CMYK] appears (p.80, p.82, p.85) in the bottom of the main window, edit window and edit image window, and colors can be checked.
- To temporarily cancel CMYK simulation, press the <Ctrl + Y> keys.

● Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) for printing with Easy-PhotoPrint (p.30, p.89).
- The rendering intent is ordinarily set to [Relative Colorimetric].
- When colors with [Relative Colorimetric] are not satisfactory, set to [Perceptual].
4 Useful Functions for Processing Large Numbers of RAW Images

Describes convenient functions for batch processing large numbers of RAW images, geared to the user who is a professional shooting large numbers of photographs in a studio environment.

Utilizing Adjusted Content (Recipe Data) .................. 56
  Saving Recipes as a File........................................... 57
  Loading and Pasting Recipes.................................. 57
  Copying a Recipe and Applying to Another Image..... 57

Batch Apply White Balance to Images (Personal White Balance) ......................................................... 58
  Registering Personal White Balance................................. 58
  Applying Personal White Balance................................... 58

Batch Save JPEG and TIFF Images (Batch Processing) ..................................................................... 59

Batch Transfer Images to Image Editing Software .. 60
Batch Change the File Name of Images..................... 61
Utilizing Adjusted Content (Recipe Data)

Any editing content (image processing conditions information) adjusted with the tool palette can be saved as a separate file from the image and loaded and applied to another image, or be copied and applied to another image. In DPP, editing data is referred to as a “recipe” (a file with .vrd as the extension).
You can edit images efficiently by selecting and adjusting one image from large numbers of images shot with the same light source and batch applying the adjustment results to a large number of images.

Recipe data also includes content that has been edited with the [RGB image adjustment] tool palette. However, adjustments in the [RAW image adjustment] tool palette that can only be adjusted for RAW images are not applied to a JPEG or TIFF image even if they are pasted.
Saving Recipes as a File

1. Select an edited image, and then select the [Edit] menu ➔ [Save recipe in file].
   ➔ The [Save as] dialog box appears.

2. Select the destination folder, enter a file name, and then click the [Save] button.

Recipe data can only be checked on screen as [Recipe data: Yes] (p.80). For that reason, it is recommended that you separately record as text information of file names and editing content so that editing content can be easily identified.

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another image.

1. Select the image from which a recipe is to be copied and then select the [Edit] menu ➔ [Copy recipe to clipboard].
   ➔ The recipe is copied.

2. Select the image to which the recipe is to be applied and then select the [Edit] menu ➔ [Paste recipe to selected image].
   ➔ The recipe is applied to the image.

Loading and Pasting Recipes

1. Select the image to which a recipe is to be applied, and then select the [Edit] menu ➔ [Read and paste recipe from file].
   ➔ The [Open] dialog box appears.

2. Select a recipe and click the [Open] button.
   ➔ The recipe is applied to the image.
Batch Apply White Balance to Images (Personal White Balance)

You can adjust the white balance of images shot in specific shooting environments and by registering personal white balance, you can batch apply white balance for specific shooting environments to a large number of images.

Registering Personal White Balance

1. Adjust the white balance.
2. In the [RAW image adjustment] tool palette, click the [Register] button.  
   → The [Register personal white balance] dialog box appears.
3. Select the button number to be registered from the list and click the [OK] button.

   ![Register personal white balance dialog box]

Applying Personal White Balance

1. In the main window, select the image to which white balance is to be applied.
2. Click the [White balance] button on the toolbar.  
   → The [White balance adjustment] dialog box appears.
3. Click the personal white balance number button that is to be applied.

   ![White balance adjustment dialog box]

   → Personal white balance is applied to all the selected images.

1. Adjust the white balance.
2. In the [RAW image adjustment] tool palette, click the [Register] button.  
   → The [Register personal white balance] dialog box appears.
3. Select the button number to be registered from the list and click the [OK] button.

   ![Register personal white balance dialog box]

Applying Personal White Balance

1. In the main window, select the image to which white balance is to be applied.
2. Click the [White balance] button on the toolbar.  
   → The [White balance adjustment] dialog box appears.
3. Click the personal white balance number button that is to be applied.

   ![White balance adjustment dialog box]

   → Personal white balance is applied to all the selected images.
Batch Save JPEG and TIFF Images (Batch Processing)

You can batch convert and save RAW images to highly versatile JPEG or TIFF images.

An image that has been trimmed (p.26) or that has had dust erased (p.43, p.44, p.46) becomes a trimmed image or a dust-erased image when converted to a JPEG or TIFF image and saved.

1. In the main window, select multiple images to be converted.
2. Click the [Batch process] button on the toolbar (p.80, p.85).
   → The [Batch settings] window appears.
3. Specify the required settings, and then click the [Execute] button.
   → The processing dialog box appears and saving begins.
   → When all the images are saved, the processing dialog box appears.

1. You cannot save edited RAW images with “Adding a Recipe and Save” in the [Batch settings] window. Perform “Adding a Recipe and Save” (p.28) individually.
2. If you have selected [New file name] in [File name], [Sequence number] has to be set.
3. Since the saving function operates independently, you can continue to operate in other windows such as the main window during the saving process.
4. If you have performed step 2 where no images have been selected, all images displayed in the main window or the edit image window undergo batch processing.
5. A trimmed (p.70) or dust-erased (p.72, p.73, p.75) JPEG or TIFF image can be saved as a separate trimmed image or dust-erased image by following the operation on this page.
6. For a list of [Batch settings] window functions, refer to p.87.
Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. The software used here as an example is Adobe Photoshop CS.

1. Select multiple images to be transferred.
2. Click the [Batch process] button on the toolbar.
   → The [Batch settings] window appears.
3. Perform settings required for transferring (e.g. file format).
4. Click the [Browse] button.

   → The [Open] dialog box appears.
5. Select Photoshop CS.
   - In the [Open] dialog box, select Photoshop CS, and click the [Open] button.
   → The [Open] dialog box closes and [Image transfer settings] in the [Batch settings] window is set to Photoshop CS.
6. Set a check mark.
7. Click the [Execute] button.
   → The processing dialog box appears and batch transfer begins.
   → When the first image has been transferred, Photoshop CS starts up and transferred images are displayed in transferred order.

   → The [Open] dialog box appears.
Batch Change the File Name of Images

1. In the main window, select multiple images of which the file names are to be changed.

2. Select the [Tools] menu ▶ [Start Rename tool].
   ▶ The rename window appears.

3. Specify the required settings and click the [Execute] button.
   ▶ Processing begins and the file names are changed.

If a file name in red text has appeared in [Modified File Name], the file name has been duplicated. Changes cannot be made if even one file name has been duplicated. Change the settings so that duplication does not occur.
DPP is software mainly aimed for advanced RAW image editing, but it also has JPEG and TIFF image editing functions. Here, the editing and saving of JPEG images is described.

**Editing JPEG and TIFF Images**

- Automatically Adjusting Brightness and Color (Tone Curve Assist).............................................................. 64
- Adjusting Brightness and Contrast............................................................................................................... 65
- Adjusting Color Tone, Color Saturation and Sharpness .................................................................................. 66
- Tone Curve Adjustment................................................................................................................................. 67
- Using Click White Balance .......................................................................................................................... 68
- Adjusting Dynamic Range............................................................................................................................ 69

**Trimming an Image**................................................................................................................................. 70

**Performing Automatic Dust Erasure Processing** .... 72
- Automatic Dust Erasure Processing in the Main Window ........................................................................... 72
- Manually Erasing Dust (Repair Function)......................... 73
  - Erasing Unwanted Parts of an Image (Copy Stamp Function)..................................................................... 75

**Re-Editing an Image**............................................................................................................................... 75

**Saving Editing Results**............................................................................................................................ 76
- Adding a Recipe and Save............................................................................................................................. 76
- Saving the Trimmed or Dust-erased Image................. 76
Editing JPEG and TIFF Images

With DPP, you can edit JPEG and TIFF images the same as with RAW images using the [RGB image adjustment] tool palette. Editing performed with DPP does not adjust an image directly, but adjusts the image by attaching and changing “image processing conditions information” (recipe data). Therefore, you can edit and the “original image data” remains unaffected.

With DPP, you can make the following adjustments to a JPEG or TIFF image using the [RGB image adjustment] tool palette.

<table>
<thead>
<tr>
<th>Adjustment Item</th>
<th>Tool Palette</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Y</td>
</tr>
<tr>
<td>Click white balance</td>
<td>Y</td>
</tr>
<tr>
<td>Contrast</td>
<td>Y</td>
</tr>
<tr>
<td>Color tone</td>
<td>Y</td>
</tr>
<tr>
<td>Color saturation</td>
<td>Y</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Y</td>
</tr>
<tr>
<td>Dynamic range</td>
<td>Y</td>
</tr>
<tr>
<td>Automatic adjustment</td>
<td>Y</td>
</tr>
<tr>
<td>Tone curve</td>
<td>Y</td>
</tr>
</tbody>
</table>

JPEG and TIFF images edited in DPP can be saved following the procedures below.

- If you add a recipe to an image and save (p.76), the original JPEG or TIFF image is saved without any deterioration.
- If you save as a separate image (p.29, p.59), the image is saved as a separate JPEG or TIFF image which reflects the results of adjustment. In this case, the image deteriorates to some extent when being edited/saved, the same as with ordinary image editing software.

Editing in the [RGB image adjustment] tool palette can also be performed on RAW images. However, the following functions are also available on the [RAW image adjustment] tool palette, so when adjusting RAW images, we recommend you use the [RAW image adjustment] tool palette and refer to the pages below to adjust.

- “Using Quick White Balance” (p.23)
- “Adjusting Dynamic Range” (p.40)
- “Changing Color Tone and Color Saturation” (p.20)
- “Adjusting Sharpness” (p.22)
Automatically Adjusting Brightness and Color (Tone Curve Assist)

[Brightness] and [Color] are automatically adjusted to create a desirable standard image. The degree of automatic adjustment can be selected from [Standard] or [High].

Click the desired automatic adjustment button.

- **Standard**: Standard automatic adjustment. Suitable for most images.
- **High**: Use when the effect achieved in standard automatic adjustment is not strong enough.

If you click the button, the tone curve as well as the [Color tone] and [Color saturation] of the [RGB image adjustment] tool palette revert to the default settings. Take care when adjusting the [Color tone] and [Color saturation] individually.

Automatic adjustment (tone curve assist) is a function for adjusting the brightness and color by automatically adjusting the tone curve (brightness and color saturation of an image before and after adjustment in the form of a graph) of an image. The adjustment result may not be as expected with the following images:

- Images which have been shot with the proper exposure
- Images where the brightness is unbalanced
- Images which are too dark
- Images which have extreme backlighting

In the main window, you can also adjust the tone curve by selecting the [Adjustment] menu > [Tone Curve Assist - Standard] or [Tone Curve Assist - High].
Adjusting Brightness and Contrast
The brightness and contrast of an image can be adjusted.

- **Brightness:** Move the slider to the right to make an image brighter and to the left to make an image darker.
- **Contrast:** Used to adjust modulation and degree of contrast of color. Move the slider to the right to make contrast of an image stronger and to the left to make contrast weaker.

The adjustment range is −100 to +100 (in 1-stop increments when entering a value).
In the main window, you can also adjust brightness with the [Brightness adjustment] dialog box which appears when you select the [Adjustment] menu → [Brightness adjustment].

The adjustment range is −100 to +100 (in 1-stop increments when entering a value).
In the main window, you can also adjust brightness with the [Brightness adjustment] dialog box which appears when you select the [Adjustment] menu → [Brightness adjustment].
Adjusting Color Tone, Color Saturation and Sharpness

You can adjust skin tone and overall color saturation and make the overall atmosphere of an image softer or harder.

- **Color tone:** Move the slider to the right to make color tones more yellow, and to the left to make color tones redder.
- **Color saturation:** Move the slider to the right to make the color deeper, and to the left to make the color weaker.
- **Sharpness:** Move the slider to the right to make an image harder, and to the left to make an image softer.

The adjustment range is –100 to +100 (in 1-stop increments when entering a value).
**Tone Curve Adjustment**

You can adjust the brightness, contrast and color of a specific area by changing the tone curve.

1. **Select the tone curve mode and interpolation method.**

   - **Right-click with the mouse inside the graph to display the menu.**

   - **Click to add a [ ] (point).**
   - **Adjust by dragging [ ].**
   - **Adjusts each channel.**
   - **Batch adjusts RGB.**

2. **Make adjustments.**

   - **The horizontal axis shows the input level and the vertical axis shows the output level.**
   - **The maximum number of [ ] is 8.**
   - **To delete a [ ], either press the <Del> key or double-click on the [ ].**

   - **The histogram display changes according to adjustment. You can also fix the histogram display to the display before any adjustments (p.52).**
   - **The tone curve mode and interpolation method for a tone curve can also be changed in [Preferences] (p.52).**
Using Click White Balance

You can adjust white balance by making a selected part of an image the standard for white. Using click white balance is effective when using it in parts of an image where white color tone has changed under the influence of a light source.

1. Click the [ ] button.

2. Click on a point that is to be the standard for white.

- The color of the image is adjusted with the point you selected as the standard for white.
- If you click on another point in the image, the white balance is adjusted again.
- To finish click white balance, click the right button on the mouse or click the [ ] button.

- The image is adjusted based on the average value of 1 x 1 pixel range from the clicked point.
- Even if you have selected a neutral gray point in an image, the result of adjustment is the same as when you select a white point.
- The histogram display changes according to adjustment. You can also fix the histogram display to the display before any adjustments (p.52).
**Adjusting Dynamic Range**

Dynamic range (width of gradation expression) from dark points to bright points in an image can be adjusted. The narrower the space between shadow point and highlight point becomes, the narrower the gradation from bright points to dark points of an image becomes.

- The setting range of shadow points is 0 to 247 (in 1-stop increments when entering a value).
- The setting range of highlight points is 8 to 255 (in 1-stop increments when entering a value).
- The histogram display changes according to adjustment. You can also fix the histogram display to the display before any adjustments (p.52).

- The horizontal axis shows the input level and the vertical axis shows the output level.
Trimming an Image
You can trim and enlarge only the part of an image you need, or change the composition of an image where an image shot horizontally becomes vertical. The trimmed image becomes a trimmed image when saved as a separate image (p.29).

1 Select the image to be trimmed.

2 Open the trimming window.
   - Select the [Tools] menu ➔ [Start Trimming tool].
   - The trimming window appears.

3 When the image has redrawn itself, select a ratio and trim.

   ![Trimming Image](image)

   - The trimmed range can be moved by dragging.
   - You can enlarge or reduce the size of the trimmed range by dragging the four corners of the trimmed range.
   - List of aspect ratios (width : height)

     ![Aspect Ratios](image)

     - [**Free**]: You can freely trim an image.
     - [**Custom**]: You can trim an image at the specified ratio.

4 Click the [OK] button to return to the main window.
   - The [ adventurers mark](p.81) appears in the trimmed image.

5 Save the trimmed image as a separate image.
   - The trimmed image becomes a separate trimmed image when saved as a separate image (p.29).
List of Trimming Functions

- Full screen display/returns to normal screen
- Ratio of trimming range (you can also enter numerical values if you have selected [Custom])
- Upper left coordinates of trimmed range (you can also enter numerical values)
- Size of trimmed range (you can also enter numerical values)
- Copies the trimmed range and applies (pastes)* it to a separate image.
- Displays borders around a trimmed range.
- Level of opacity outside a trimmed range
- Switches between displayed images.*

* Operates when you have selected multiple images and the trimming window is displayed.

- The image does not become a trimmed image by performing “Adding a Recipe and Save” (p.76). You must save the image as a separate image (p.29).
- If you print a trimmed image without converting and saving with Easy-PhotoPrint (p.30), the untrimmed image is printed. Convert the image to a separate image and save before printing (p.29).
- Changes are not saved to a trimmed image, merely information about the trimmed range is saved in the image. For that reason, you can return an image to its original condition at any time (p.75).
- Check trimmed images in the trimming window. You cannot check them in other windows.
- Each operation can also be performed with the menu which appears when you right-click with the mouse on the image.
- To switch between full screen display/normal screen display, press the <F11> key or the <Alt> + <Enter> keys.
- You can also press the <Esc> key to return the full screen display to the normal screen display.
- If you have clicked [Apply All], the trimming range you have copied is applied to all images selected when the trimming window is displayed.

- If [Free] has been selected in the [Aspect ratio] list box, you can also drag the borders of the trimmed range to change its range.
- To apply the same trimming range to multiple images, use the [Copy], [Paste] and [Apply All] buttons.
Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera that can attach this data, can be used to automatically erase dust spots. The dust-erased image becomes a dust-erased image when saved as a separate image (p.29).

1. In the main window, select an image appended with Dust Delete Data.
2. Select the [Tools] menu ▶ [Start Stamp tool].
   - The copy stamp window appears.
3. When the image has redrawn itself, click the [Apply Dust Delete Data] button.
   - Dust spots are erased in a single operation.
   - You can check the erased dust spots one by one by pressing the <Shift + F> keys. (Press the <Shift + B> keys to return to the previous dust spot.) Also, you can cancel only the displayed dust-erased spot by pressing the <Shift + Del> keys.
4. Click the [OK] button to return to the main window.
   - The [ ] mark (p.81) is displayed on an image from which dust spots have been erased.

5. Save as a separate image.
   - The image becomes a dust-erased image by saving as a separate image (p.29).
   - Even if you have saved by performing “Adding a Recipe and Save” (p.76), a dust-erased image is not created, merely information about dust erasure processing is saved to an image. You must save the image as a separate image (p.29).
     - A dust-erased image does not change, merely dust erasure information is saved to the image. For that reason, you can return an image to its original condition at any time (p.75).
     - Check dust-erased images in the copy stamp window. You cannot check them in other windows.
     - In automatic dust erasure processing, dust spots are erased based on information relating to dust saved in the Dust Delete Data. However, there may be cases where you will not be able to erase dust spots depending on the type of dust. If this occurs, erase those dust spots using the repair function (p.73) or the copy stamp function (p.75).
     - To switch between full screen display/normal screen display, press the <F11> key or the <Alt> + <Enter> keys.
     - You can also press the <Esc> key to return the full screen display to the normal screen display.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in an image appended with Dust Delete Data.

Select an image appended with Dust Delete Data, and then select the [Adjustment] menu ▶ [Apply Dust Delete Data].
   - Dust spots in the selected image are erased in a single operation.
Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. The dust-erased image becomes a dust-erased image when saved as a separate image (p.29).

1. In the main window, select the image you want to erase dust spots.
2. Select the [Tools] menu ➤ [Start Stamp tool].
   ➤ The copy stamp window appears.
3. When the image has redrawn itself, double-click the point from where dust is to be erased.
4. Click the button that matches the dust spots to be erased.
   - If the dust spot is dark in color, click the [ ] button, and if the dust spot is light in color, click the [ ] button.
   - When you move the cursor over the image, the dust erasure range appears as [ ].
5. Place the dust spot to be erased in the image within the [ ] and click.
   ➤ The dust spot within the [ ] is erased.
   - Click on another part of the image to continue to erase dust spots in the image.
   - To erase dust in another part of the image, either right-click with the mouse, or click the button clicked in step 4 again to cancel dust erasure processing and perform the operation again from step 3.
   - When the dust spot cannot be erased, [ ] is displayed.
6. Click the [OK] button to return to the main window.
   ➤ The [ ] mark (p.81) is displayed on an image from which dust spots have been erased.
7. Save as a separate image.
   - The image becomes a dust-erased image by saving as a separate image (p.29).
You can apply the dust erasure in the same place in multiple images using the [Copy] and [Paste] buttons.

A dust-erased image does not change, merely dust erasure information is saved to the image. For that reason, you can return an image to its original condition at any time (p.75).

Check dust-erased images in the copy stamp window. You cannot check them in other windows.

[Radius] that sets the dust-erasure range can be set in a range of 5 to 100 (in one pixel units).

Spots of dust can be erased with the repair function. There may be cases where you will not be able to erase lines of dust. If this occurs, erase the dust with the copy stamp function (p.75).

When you have erased several dust spots in an image, press the <Shift + B> keys to display the previous dust-erased spot and the <Shift + F> keys to display the next dust-erased spot successively.

Also, the dust-erased spots are automatically recorded. For this reason, you can display in order the same dust-erased spots as the dust-erased image when switching to another image and pressing the <Ctrl + F> or <Ctrl + B> keys.

To switch between full screen display/normal screen display, press the <F11> key or the <Alt> + <Enter> keys.

You can also press the <Esc> key to return the full screen display to the normal screen display.

Even if you have saved by performing “Adding a Recipe and Save” (p.76), a dust-erased image is not created, merely information about dust erasure processing is saved to an image. You must save the image as a separate image (p.29).
Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part of the image to an unwanted part of the image. The corrected image becomes a corrected image by converting to a JPEG or TIFF image and saving (p.29).

1 Follow steps 1 to 3 in “Manually Erasing Dust (Repair Function)” (p.73).

2 Specify the section to be copied.
   - Click the [Select Copy Source] button and then click on the section that is to be the copy source.
   - To change the section that is to be the copy source, perform the operation above again.
   - You can also specify the section to be copied by clicking on the section to be copied while holding down the <Alt> key.
   - To fix the position of the copy source, check mark the [Fix Copy Source position].

3 Correct the image.
   - Click or drag on the section you want to correct on the image. [+ ] in the window indicates the copy source and [ ] indicates the copy destination.
   - The copied image is pasted in the position to which it was dragged.
   - For [Pen type], you can select from [Brush] (the pasted image’s borders simulate a brush) and [Pencil] (the pasted image’s borders are sharp).
   - Continue by performing the same operations as steps 6 and 7 of “Manually Erasing Dust (Repair Function)” (p.73).

Re-Editing an Image

Since only the image processing conditions of an edited JPEG or TIFF image is changed and displayed, the original image data itself remains unaffected in its original condition. For that reason, you can cancel all adjustments in an image and restore it to the last saved condition or to the image that you originally shot.

1 Select the image that is to be re-edited.

2 Select the [Adjustment] menu ▶ desired item.

   - The image reverts to the conditions of the selected item.
Saving Editing Results

Adding a Recipe and Save

You can save adjusted contents as a recipe (image processing conditions information) to an image.

Select the [File] menu ▶ desired item.

File

- Open in Edit window
- Open in Edit window (100% view)
- Add recipe and save
- Add recipe and save as...
- Add thumbnail to image and save
- Convert and save...
- Batch process...
- Create new folder...
- Print...
- Print with detailed setting...
- Contact Sheet Prints...
- Plug-in printing
- Delete
- Info
- Exit

Your adjustments are saved to the image.

Saving the Trimmed or Dust-erased Image

JPEG or TIFF images that have been trimmed (p.70) or have had dust erased (p.72, p.73, p.75) become separate trimmed or dust-erased images by following the procedure and saving as separate images in “Saving JPEG and TIFF Images” (p.29) or “Batch Saving JPEG and TIFF Images (Batch Processing)” (p.59).
This reference section has been provided to enhance your experience using DPP. It contains various troubleshooting solutions, how to delete DPP from your computer, explanations of the various windows and a glossary. An Index is provided at the end of the chapter for you to easily find information you are looking for.

Troubleshooting................................. 78
Deleting the Software (Uninstalling)............ 79
List of Main Window Functions............... 80
Image Frame Information in the Main Window and Edit Image Window.......... 81
List of Edit Window Functions ................. 82
List of Tool Palette Functions in the Edit Window and the Edit Image Window.......... 83
List of Quick Check Window Functions ........ 84
List of Edit Image Window Functions .......... 85
List of Convert/Save One Image Window Functions 86
List of Convert/Save Multiple Images Window (Batch Processing) Functions .......... 87
Glossary ................................................. 88
Index.......................................................... 90
  About This Instruction Manual ................. 94
  Trademark Acknowledgments ................. 94
Troubleshooting

If DPP is not operating correctly, refer to the items below.

Installation could not be completed correctly

- You cannot install the software if a user setting other than [Computer administrator] privilege or [Administrator] privilege is selected. Select the [Computer administrator] privilege in Windows XP or the [Administrator] privilege user setting in Windows 2000. For detailed information on selecting the user setting, refer to the computer’s instruction manual.

DPP does not work

- DPP does not operate correctly on a computer if its system requirements does not meet. Use DPP on a computer with compatible system requirements (p.3).
- Even if your computer has the RAM capacity (memory) described in the system requirements (p.3), if other applications are running at the same time as DPP, you may not have sufficient RAM (memory). Exit any applications other than DPP.

Images do not display properly

- Images that are not supported by DPP do not display. There are various types of JPEG and TIFF images, so JPEG images other than Exif 2.2 and 2.21 compatible images and TIFF images other than Exif compatible images may not display properly (p.3).
- A trimmed range cannot be checked other than in the trimming window (p.26, p.70).
  Either check the image in the trimming window or convert the image and save it as a JPEG or TIFF image (p.29, p.59).
- A dust-erased image cannot be checked other than in the copy stamp window (p.43, p.44, p.46, p.72, p.73, p.75).
  Either check the image in the copy stamp window or convert the image and save it as a JPEG or TIFF image (p.29, p.59).

An image could not be adjusted

- The RAW image adjustment function (p.10) cannot be used on JPEG and TIFF images. Adjust these images with the RGB image adjustment function (p.63).
- PowerShot Pro1 RAW images cannot be adjusted with the RAW image adjustment function. Adjust these images with the RGB image adjustment function (p.63).

A recipe could not be pasted (applied) to another image

- You cannot paste (apply) rotation (p.8, p.18, p.80, p.84, p.85), trimming (p.26, p.70), dust erasure (copy stamp) (p.43, p.44, p.46, p.72, p.73, p.75) of an image to another image as a recipe. Trim the image or erase dust of the image using the copy/paste function in each window and rotate each image individually.
- The editing content of RAW images that has been adjusted with the RAW image adjustment function cannot be applied to JPEG images (p.56).

Color appears weak in the image when view with other software

- A RAW image which has a color space other than sRGB set (p.46, p.53) and is then converted and saved as a JPEG or TIFF images will appear weak in color when viewed in software that is only compatible with sRGB color space. In this case, set the RAW image color space to sRGB, convert again to a JPEG or TIFF image and save, and then view this image.
The colors in printed images are incorrect

- If the color of the monitor that displays an image is not adjusted correctly, or if a profile for a printer that is to print images, has not been set up, the color of the image displayed on screen and the color of the printed photograph may differ greatly. If the color of the monitor that displays images is corrected (p.53, p.54) and a profile for a printer is set up correctly, the color of a printed photograph and the color of an image on screen can be more closely matched. Printing with a Canon printer (p.30, p.48, p.49) automatically sets up printer profiles, so you only need to set the color of the monitor to bring the colors closer together.

- When printing with Easy-PhotoPrint and the Easy-PhotoPrint automatic compensation function and the various types of image adjustment functions are operating, colors are not printed correctly. Cancel all Easy-PhotoPrint image adjustment functions (p.31).

- Where the printer driver is set to perform adjustment of images, printing colors of a picture does not approximate the colors on screen even when a printer profile is set. Set the driver not to perform adjustment of images.

Printing a large number of images in batches cannot be performed

- If a large number of images are printed in batches, printing may stop in the middle or the images may not be printed. Reduce the number of images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

- Delete [CRW_YYYY.THM] (camera index display image) if it remains in the folder from which images have been deleted (p.33).
  * Numbers are entered for [YYYY] in the file name.

The image information does not display

- A JPEG image set to Adobe RGB and shot with the EOS 10D and EOS DIGITAL REBEL/300D DIGITAL may not display image information.

Deleting the Software (Uninstalling)

- Exit any applications before uninstalling the software.
- Log in under [Computer administrator]/[Administrator] privileges when uninstalling the software.
- To prevent computer malfunctions, always restart your computer after you have uninstalled the software. Re-installing the software without first restarting your computer is particularly likely to result in computer malfunctions.

1. Select the [Start] button ➔ [All Programs] ([Programs] in Windows 2000) ➔ [Canon Utilities] ➔ [Digital Photo Professional] ➔ [Digital Photo Professional Uninstall].
2. Proceed with the uninstallation as directed by the on-screen messages.
   ➔ The software is uninstalled.
List of Main Window Functions

- Selects all images
- Shows/hides the folder area
- Switches to the edit image window
- Recipe attachment status (p.57)
- Number of images
- Number of selected images
- CMYK simulation display (p.53, p.54)
- Batch conversion/saving (p.59)
- Check marks (p.16)
- Removes check marks (p.16)
- Image rotation (90 degree units)
- White balance adjustment (p.22, p.39)
- Click white balance (p.23)
- Brightness adjustment (p.18)

Folder path

Toolbar *1

Folder area *2

Information display *3

*1 To switch between show/hide, select the [View] menu » [Toolbar].
*2 The images inside the folders selected here are displayed in a thumbnail list on the right.
*3 Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image when you click [Click (RAW)] button on the toolbar.
Image Frame Information in the Main Window and Edit Image Window

Information displayed when [Large Thumbnail] (p.8) is selected

- **Check mark** (p.15, p.16)
- **Brightness adjustment value** (p.18) *1
- **White balance icon** (p.22) *1
- **Copy stamp mark** (p.43, p.44, p.46, p.72, p.73, p.75)
- **Trimming mark** (p.26, p.70)
- **Aperture numerical value** *2
- **File name**
- **RAW mark** *3
- **RAW image adjustment mark** *1 *4
- **RGB image adjustment mark** *1 *5
- **Unsaved editing content mark**
- **Shutter speed** *2

*1 Does not display with [Small Thumbnail].
*2 Does not display with [Middle Thumbnail] or [Small Thumbnail].
*3 Displays in a RAW image (with [Small Thumbnail] (p.8), [R] displays). Does not display in a PowerShot Pro1 RAW image.
*4 Displays in an image edited with the [RAW image adjustment] tool palette in the edit window and the edit image window.
*5 Displays in an image edited with the [RGB image adjustment] tool palette in the edit window and the edit image window.
List of Edit Window Functions

- Path and file name of image
- Tool palette (p.83) *1
- Information display *2
- Operating mode (p.50)
- CMYK simulation display (p.53, p.54)
- Image color space *3 and work color space (p.46, p.53)

*1 To switch between show/hide, select the [View] menu > [Tool palette].
*2 Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image.
*3 Raw images are displayed with [RAW].
List of Tool Palette Functions in the Edit Window and the Edit Image Window

**RAW Image Adjustment Tool Palette**
- Brightness adjustment (p.18)
- White balance adjustment (p.22, p.23, p.39)
- Picture Style settings (p.19)
- Dynamic range adjustment (p.40)
- Contrast adjustment (p.20)
- Color tone and color saturation adjustment (p.20)
- Sharpness adjustment (p.22)
- Enlargement display position *1

**RGB Image Adjustment Tool Palette**
- Automatic adjustment (tone curve assist) (p.24, p.64)
- Click white balance (p.68)
- Tone curve adjustment (p.41, p.67)
- Dynamic range adjustment (p.69)
- Brightness and contrast adjustment (p.65)
- Color tone and color saturation adjustment (p.66)
- Sharpness adjustment (p.66)
- Enlargement display position *1

*1 If an enlarged image is displayed, the enlargement position displayed can be moved by dragging. (Displays when the [Docking display] (p.52) is set and the edit window or the edit image window has been enlarged.)
List of Quick Check Window Functions

- Path and file name of image
- 50% view/full view *1
- Displays the image in full screen. *2
- Check marks (p.15)
- Removes check marks (p.15).
- Image rotation (90 degree units)
- Switches between images.

*1 In [50% view], you can move the display position by dragging.
*2 To return to the normal screen, press the <Esc> key.
List of Edit Image Window Functions

- Toolbar
  - Shows/hides tool palette
  - Shows/hides thumbnail display area
  - Switches to main window (p.25)
- Thumbnail display area *3
  - Image color space *1 and work color space (p.46, p.53)
- Operating mode (p.50)
  - CMYK simulation display (p.53, p.54)
- Information display *2
  - Image color space *1 and work color space (p.46, p.53)
  - CMYK simulation display (p.53, p.54)
- Tool palette (p.83)
  - Tool palette
- Shows/hides grid *4
  - Size of image display
  - Switches between display images
  - Batch conversion/saving
- Image rotation (90 degree units)
  - Batch conversion/saving

*1 RAW images are displayed with [RAW].
*2 Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image.
*3 Displays images selected in the main window. The image selected here is enlarged and displayed on the right.
*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.51).
**List of Convert/Save One Image Window Functions**

<table>
<thead>
<tr>
<th>Types of image</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exif-JPEG</td>
<td>.JPG</td>
</tr>
<tr>
<td>Exif-TIFF 8bit</td>
<td>.TIF</td>
</tr>
<tr>
<td>TIFF 16bit</td>
<td>.TIF</td>
</tr>
</tbody>
</table>

- Save destination
- Save
- JPEG compression rate *3
- Embeds of ICC profiles (p.88) *2
- Size changing *4
- File name
- Resolution *1

*1 The setting range is 1 to 60,000 dpi.
*2 Color space (p.89) information that is set in an image is attached to an ICC profile. Even if you remove the check mark from images that have been set to Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.46, p.53), the ICC profiles are embedded automatically.
*3 The setting range is 1 to 10. The higher the numerical value, the higher the image quality becomes.
*4 The larger of the two values set in [Width] and [Height] is applied to the longer edge of an image and change its size.
List of Convert/Save Multiple Images Window (Batch Processing) Functions

The setting range is 1 to 60,000 dpi.

*2 Color space (p.89) information that is set in an image is attached to an ICC profile. Even if you remove the check mark from images that have been set to Apple RGB, ColorMatch RGB, Wide Gamut RGB color space (p.46, p.53), the ICC profiles are embedded automatically.

The setting range is 1 to 10. The higher the numerical value, the higher the image quality becomes.

The larger of the two values set in [Width] and [Height] is applied to the longer edge of an image and change its size.

To convert RAW images only, instead of clicking the [Execute] button, click the button that appears when you click the [Batch process] button (p.80, p.85) without an image selected in the main window or the edit image window.

### File names of images to be batch saved

- DPP_001.cr2
- DPP_002.cr2
- DPP_003.cr2
- DPP_004.cr2
- DPP_005.cr2
- DPP_006.cr2
- DPP_007.cr2
- DPP_008.cr2
- DPP_009.cr2
- DPP_010.cr2

### Embeds ICC profiles (p.88) *2

### Resolution *1

### Size changing *4

### Images to be converted are limited to RAW images *5

### Save destination

- C:\Documents and Settings\0000\My Documents\*

### Types of image

<table>
<thead>
<tr>
<th>Type of image</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exif-JPEG</td>
<td>.JPG</td>
</tr>
<tr>
<td>Exif-TIFF 8bit</td>
<td>.TIF</td>
</tr>
<tr>
<td>TIFF 16bit</td>
<td>.TIF</td>
</tr>
</tbody>
</table>

### JPEG compression rate *3

- The larger of the two values set in [Width] and [Height] is applied to the longer edge of an image and change its size.
- To convert RAW images only, instead of clicking the [Execute] button, click the button that appears when you click the [Batch process] button (p.80, p.85) without an image selected in the main window or the edit image window.

### File name

- [String] [Sequence number] [Exif] [DPP] [JPEG], [DPP] [JPEG]...

### Batch transfer to other image editing software (p.60)

### List of Convert/Save Multiple Images Window (Batch Processing) Functions

<table>
<thead>
<tr>
<th>File names of images to be batch saved</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPP_001.cr2, DPP_002.cr2, DPP_003.cr2, DPP_004.cr2, DPP_005.cr2, DPP_006.cr2, DPP_007.cr2, DPP_008.cr2, DPP_009.cr2, DPP_010.cr2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Embeds ICC profiles (p.88) *2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exif-JPEG, Exif-TIFF 8bit, TIFF 16bit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resolution *1</th>
</tr>
</thead>
<tbody>
<tr>
<td>The setting range is 1 to 60,000 dpi.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Size changing *4</th>
</tr>
</thead>
<tbody>
<tr>
<td>The larger of the two values set in [Width] and [Height] is applied to the longer edge of an image and change its size.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Images to be converted are limited to RAW images *5</th>
</tr>
</thead>
<tbody>
<tr>
<td>To convert RAW images only, instead of clicking the [Execute] button, click the button that appears when you click the [Batch process] button (p.80, p.85) without an image selected in the main window or the edit image window.</td>
</tr>
</tbody>
</table>
RAW image
EOS DIGITAL camera RAW images are recorded in an uncompressed 12bit format. Because RAW images are special images in an undeveloped status, you need software with development processing functions such as DPP in order to view them. The advantage of the undeveloped RAW images is that you can make a variety of adjustments to RAW images with almost no deterioration of the image.
* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image
The most general image in non-reversible compressed 8bit format. The advantage of this is that by saving at a high compression rate, the file size can be small of even image data that has a high pixel count. Because during saving and compression part of the data is thinned out to make the file size small, every time you edit or save, the image deteriorates.
With DPP, even if you repeat editing/saving, only the recipe data is modified, and no overwriting or compression occurs so the original image data does not deteriorate.
* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image
Bitmap-format image recorded in a 8bit/16bit uncompressed format. Because TIFF images are in uncompressed format, they are suitable for saving an image while maintaining the original high image quality.
* TIFF is an abbreviation of “Tagged Image File Format”.

bit number
Binary unit of information volume in the color of an image. The number shows the number of bits per pixel. The larger the number of bits, the more the color numbers and the gradation becomes smoother. A one-bit image is a black-and-white image.

Color Management System (Color Matching)
Digital cameras that shoot images, monitors that display images, and printers that print images each have a different way of creating color. For this reason, there may be a difference between the color of an image you view on a monitor and the color of an image you have printed.
A color management system is a system for managing color in order to bring these colors closer together. With DPP, you can more closely match color between different devices using ICC profiles between different devices.

ICC profiles
ICC profiles are files containing color information such as color characteristics and color space for various devices, set by the ICC (International Color Consortium). Most devices such as the monitor we use to view images or the printer we use to print images can be managed (color management) using these ICC profiles and the color between different devices can be more closely matched.
DPP has color management that uses these ICC profiles.

Recipe
The “Image processing conditions information” for RAW images that can be edited in DPP is called a “recipe". Further, in DPP, you can perform image editing on JPEG and TIFF images that use “recipes” as with RAW images.
### Color space

A color space is the reproducible color range (color gamut characteristics). DPP supports the following five kinds of color space.

- **sRGB**: Standard color space for Windows. Widely used for the standard color space of monitors, digital cameras, and scanners.
- **Adobe RGB**: A wider color space than sRGB. Mainly used for printing for business purposes.
- **Apple RGB**: Standard color space for Macintosh. A slightly wider color space than sRGB.
- **ColorMatch RGB**: A slightly wider color space than sRGB. Mainly used for printing for business purposes.
- **Wide Gamut RGB**: A wider color space than Adobe RGB.

Refer to the color chart below for the color area of each color space.

### Color chart of color spaces compatible with DPP

![Color chart of color spaces compatible with DPP](image)

- **Color range that can be seen by the human eye.**

### CMYK simulation profiles

A CMYK simulation profile is a profile for simulating colors in a CMYK environment on printers etc. With DPP, you can simulate color with four types of profile.

- **Euro Standard**: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- **JMPA**: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- **JapanColor2001 type3**: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

### Rendering intent

Rendering intents are color conversion methods when printing an image. The conversion method of each rendering intent is shown below.

- **Perceptual**: Before and after conversion, all colors are converted to maintain the relationship between colors. Even where colors slightly change, you can print a natural-looking image which has maintained color harmony. However, depending on the image, the saturation may change overall.
- **Relative Colorimetric**: There will not be much conversion to colors which are similar before and after conversion, but colors which are not similar are converted appropriately. Because there are little changes to similar colors which comprise most of an image, you can print a natural-looking image in which the degree of color has not changed greatly. However, depending on the image, there are cases where the overall tone of an image changes somewhat as colors which are not similar and highlights change.
# Index

## A

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Recipe and Save</td>
<td>11, 28, 76</td>
</tr>
<tr>
<td>Adjusting (JPEG or TIFF Image)</td>
<td></td>
</tr>
<tr>
<td>Automatic Adjustment (Tone Curve Assist)</td>
<td>64</td>
</tr>
<tr>
<td>Brightness</td>
<td>65</td>
</tr>
<tr>
<td>Click White Balance</td>
<td>68</td>
</tr>
<tr>
<td>Color Saturation</td>
<td>66</td>
</tr>
<tr>
<td>Color Tone</td>
<td>66</td>
</tr>
<tr>
<td>Contrast</td>
<td>65</td>
</tr>
<tr>
<td>Dynamic Range</td>
<td>69</td>
</tr>
<tr>
<td>RGB Image Adjustment Tool Palette</td>
<td>63, 83</td>
</tr>
<tr>
<td>Sharpness</td>
<td>66</td>
</tr>
<tr>
<td>Tone Curve Adjustment</td>
<td>67</td>
</tr>
<tr>
<td>Adjusting (RAW image)</td>
<td></td>
</tr>
<tr>
<td>Automatic Adjustment (Tone Curve Assist)</td>
<td>24</td>
</tr>
<tr>
<td>Brightness</td>
<td>18</td>
</tr>
<tr>
<td>Click White Balance</td>
<td>23</td>
</tr>
<tr>
<td>Color Saturation</td>
<td>20</td>
</tr>
<tr>
<td>Color Temperature</td>
<td>39</td>
</tr>
<tr>
<td>Color Tone</td>
<td>20</td>
</tr>
<tr>
<td>Color Wheel</td>
<td>39</td>
</tr>
<tr>
<td>Contrast</td>
<td>20</td>
</tr>
<tr>
<td>Dynamic Range</td>
<td>40</td>
</tr>
<tr>
<td>Filter Effect</td>
<td>21</td>
</tr>
<tr>
<td>Monochrome</td>
<td>21</td>
</tr>
<tr>
<td>Personal White Balance</td>
<td>58</td>
</tr>
<tr>
<td>Picture Style</td>
<td>19</td>
</tr>
<tr>
<td>Sharpness</td>
<td>22</td>
</tr>
<tr>
<td>Tone Curve Adjustment</td>
<td>41</td>
</tr>
<tr>
<td>Toning Effect</td>
<td>21</td>
</tr>
<tr>
<td>Tool Palette</td>
<td>10, 83</td>
</tr>
<tr>
<td>White Balance</td>
<td>22</td>
</tr>
<tr>
<td>Adobe RGB</td>
<td>89</td>
</tr>
<tr>
<td>Apple RGB</td>
<td>89</td>
</tr>
<tr>
<td>Automatic Adjustment (Tone Curve Assist)</td>
<td>24, 64</td>
</tr>
<tr>
<td>Automatic Dust Erasure Processing</td>
<td>43, 72</td>
</tr>
</tbody>
</table>

## B

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Apply White Balance to Images (Personal White Balance)</td>
<td>58</td>
</tr>
<tr>
<td>Batch Change the File Name of Images</td>
<td>61</td>
</tr>
<tr>
<td>Batch Convert/Save Images (Batch Process)</td>
<td>59</td>
</tr>
<tr>
<td>Batch Process (Batch Save JPEG and TIFF Images)</td>
<td>59, 87</td>
</tr>
<tr>
<td>Batch Process of Multiple Images</td>
<td></td>
</tr>
<tr>
<td>Change the File Name</td>
<td>61</td>
</tr>
<tr>
<td>Convert/Save (Batch Process)</td>
<td>59, 87</td>
</tr>
<tr>
<td>Personal White Balance</td>
<td>58</td>
</tr>
<tr>
<td>Recipe Data</td>
<td>56</td>
</tr>
<tr>
<td>Transfer</td>
<td>60</td>
</tr>
<tr>
<td>Batch Settings Window</td>
<td>59, 60, 87</td>
</tr>
<tr>
<td>Batch Transfer Images</td>
<td>60</td>
</tr>
<tr>
<td>Before/After Comparison Display</td>
<td>38</td>
</tr>
<tr>
<td>bit Number</td>
<td>88</td>
</tr>
<tr>
<td>Bookmark</td>
<td>36</td>
</tr>
<tr>
<td>Brightness</td>
<td>18, 65</td>
</tr>
</tbody>
</table>

## C

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Mark</td>
<td>15, 16</td>
</tr>
<tr>
<td>Click White Balance</td>
<td>23, 68</td>
</tr>
<tr>
<td>CMYK Simulation</td>
<td>53, 54, 89</td>
</tr>
<tr>
<td>Color Chart</td>
<td>89</td>
</tr>
<tr>
<td>Color Management (Color Matching)</td>
<td>88</td>
</tr>
<tr>
<td>Color Setting of the Monitor (Profiles)</td>
<td>53</td>
</tr>
<tr>
<td>Color Setting of the Printer (Profiles)</td>
<td>53, 54</td>
</tr>
<tr>
<td>Color Space</td>
<td>89</td>
</tr>
<tr>
<td>ICC Profiles</td>
<td>88</td>
</tr>
<tr>
<td>Color Management (Preferences)</td>
<td>53</td>
</tr>
<tr>
<td>Color Saturation</td>
<td>20, 66</td>
</tr>
<tr>
<td>Color Setting of the Monitor (Profiles)</td>
<td>53</td>
</tr>
<tr>
<td>Color Setting of the Printer (Profiles)</td>
<td>53, 54</td>
</tr>
<tr>
<td>Color Space</td>
<td>89</td>
</tr>
<tr>
<td>Adobe RGB</td>
<td>89</td>
</tr>
<tr>
<td>Apple RGB</td>
<td>89</td>
</tr>
<tr>
<td>Color Space Setting for Each Image</td>
<td>46</td>
</tr>
<tr>
<td>ColorMatch RGB</td>
<td>89</td>
</tr>
<tr>
<td>Default Setting of Color Space</td>
<td>53</td>
</tr>
<tr>
<td>sRGB</td>
<td>89</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Wide Gamut RGB</td>
<td>89</td>
</tr>
<tr>
<td>Color Space Setting for Each Image</td>
<td>46</td>
</tr>
<tr>
<td>Color Temperature</td>
<td>39</td>
</tr>
<tr>
<td>Color Tone</td>
<td>20, 66</td>
</tr>
<tr>
<td>Color Wheel</td>
<td>39</td>
</tr>
<tr>
<td>ColorMatch RGB</td>
<td>89</td>
</tr>
<tr>
<td>Contact Sheet Printing (Printing a Thumbnail List)</td>
<td>47</td>
</tr>
<tr>
<td>Contrast</td>
<td>20, 65</td>
</tr>
<tr>
<td>Convert to JPEG or TIFF Image and Save</td>
<td>29, 59, 86, 87</td>
</tr>
<tr>
<td>Copy Stamp (Image Correction)</td>
<td>46, 75</td>
</tr>
<tr>
<td>Copying and Pasting (Applying) Recipes</td>
<td>57</td>
</tr>
<tr>
<td>Correct Images (Copy Stamp Function)</td>
<td>46, 75</td>
</tr>
<tr>
<td>Creating a Folder</td>
<td>34</td>
</tr>
<tr>
<td>Default Setting of Color Space</td>
<td>53</td>
</tr>
<tr>
<td>Delete Images</td>
<td>33</td>
</tr>
<tr>
<td>Deleting the Software (Uninstalling)</td>
<td>79</td>
</tr>
<tr>
<td>Detailed Setting Printing (Printing with Shooting Information)</td>
<td>47</td>
</tr>
<tr>
<td>Display</td>
<td>38</td>
</tr>
<tr>
<td>Before/After Comparison Display</td>
<td>9, 82</td>
</tr>
<tr>
<td>Enlarged Display (Edit Window)</td>
<td>14, 84</td>
</tr>
<tr>
<td>Enlarged Display (Quick Check Window)</td>
<td>8, 17</td>
</tr>
<tr>
<td>Shooting Information Display</td>
<td>8, 80</td>
</tr>
<tr>
<td>Thumbnail Display (Main Window)</td>
<td>25, 85</td>
</tr>
<tr>
<td>Display and Enlarged Display (Edit Image Window)</td>
<td>8, 80</td>
</tr>
<tr>
<td>Display and Enlarged Display (Quick Check Window)</td>
<td>14, 84</td>
</tr>
<tr>
<td>Downloading an Image to Your Computer</td>
<td>6</td>
</tr>
<tr>
<td>Downloading Images from a Camera</td>
<td>6</td>
</tr>
<tr>
<td>Downloading Images from a Card Reader</td>
<td>35</td>
</tr>
<tr>
<td>Downloading Images from a Camera</td>
<td>6</td>
</tr>
<tr>
<td>Dust Delete Data</td>
<td>43, 72</td>
</tr>
<tr>
<td>Dust Erasure Processing</td>
<td>43, 72</td>
</tr>
<tr>
<td>Automatic Dust Erasure Processing</td>
<td>46, 75</td>
</tr>
<tr>
<td>Image Correction (Copy Stamp Function)</td>
<td>46, 75</td>
</tr>
<tr>
<td>Manual Dust Erasure (Repair Function)</td>
<td>44, 73</td>
</tr>
<tr>
<td>Dynamic Range</td>
<td>40, 69</td>
</tr>
<tr>
<td>E</td>
<td>25, 85</td>
</tr>
<tr>
<td>Edit Image Window</td>
<td>25, 85</td>
</tr>
<tr>
<td>Edit Window</td>
<td>9, 82</td>
</tr>
<tr>
<td>Editing</td>
<td>9, 82</td>
</tr>
<tr>
<td>Enlarged Display (Edit Window)</td>
<td>9, 82</td>
</tr>
<tr>
<td>Enlarged Display (Quick Check Window)</td>
<td>84</td>
</tr>
<tr>
<td>EOS Utility</td>
<td>6, 7</td>
</tr>
<tr>
<td>Exiting DPP</td>
<td>12</td>
</tr>
<tr>
<td>F</td>
<td>21</td>
</tr>
<tr>
<td>Filter Effect</td>
<td>21</td>
</tr>
<tr>
<td>G</td>
<td>50</td>
</tr>
<tr>
<td>General Settings (Preferences)</td>
<td>50</td>
</tr>
<tr>
<td>Help</td>
<td>1</td>
</tr>
<tr>
<td>I</td>
<td>88</td>
</tr>
<tr>
<td>ICC Profiles</td>
<td>88</td>
</tr>
<tr>
<td>Image Frame Information (Image Marks)</td>
<td>81</td>
</tr>
<tr>
<td>Image Marks (Image Frame Information)</td>
<td>81</td>
</tr>
<tr>
<td>Image Quality</td>
<td>17</td>
</tr>
<tr>
<td>Improve the Quality of an Image (Main Window)</td>
<td>17</td>
</tr>
<tr>
<td>Improve the Quality of an Image (Main Window)</td>
<td>17</td>
</tr>
<tr>
<td>J</td>
<td>88</td>
</tr>
<tr>
<td>JPEG Image</td>
<td>88</td>
</tr>
<tr>
<td>L</td>
<td>63</td>
</tr>
<tr>
<td>List of Available Adjustments</td>
<td>63</td>
</tr>
<tr>
<td>JPEG and TIFF Image</td>
<td>10</td>
</tr>
<tr>
<td>RAW Image</td>
<td>10</td>
</tr>
<tr>
<td>Loading and Pasting (Applying) Recipes</td>
<td>57</td>
</tr>
<tr>
<td>M</td>
<td>8, 80</td>
</tr>
<tr>
<td>Main Window</td>
<td>8, 80</td>
</tr>
</tbody>
</table>

*Note: The table is a simplified representation of the contents. The full table includes a broader range of topics and pages.*
About This Instruction Manual

- It is prohibited to reproduce, in whole or part, the contents of this Instruction Manual without permission.
- Canon may change without notice the software specifications and contents of this Instruction Manual.
- The software screens and displays printed in this Instruction Manual may differ slightly from the actual software.
- The content of this Instruction Manual has been reviewed thoroughly. However, if you should notice any errors or omissions, please contact a Canon Service Center.
- Please note that irrespective of the above-mentioned, Canon does not take responsibility for the outcome of the operation of the software.

Trademark Acknowledgments

- IBM is a registered trademark of International Business Machines Corporation.
- Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Adobe and Photoshop are registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
- Other names and products not mentioned above may be registered trademarks or trademarks of their respective companies.